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Description 

This course was developed to introduce the Drainage and Utilities Workflow and OpenRoads Designer 

CONNECT Edition tools for drainage design and modeling on Florida Department of Transportation (FDOT) 

projects. The curriculum was developed within the FDOTCONNECT Workspace to provide sample exercises 

for many of the Drainage Tools on a sample project data set.  Participants of this course will be introduced to the 

newest OpenRoads environment and a Workflow for designing two dimensional (2D) Plans, Profiles, and three 

dimensional (3D) Models for drainage related Construction Deliverables. 

Objectives 

• Finding additional learning resources and training materials for OpenRoads Designer CONNECT 

Edition and the general process using Drainage and Utilities Workflow to design storm drain 

systems 

• Various file types used within the Drainage and Utilities Workflow 

• How to create and prepare a drainage file for design 

• Navigating the interface for basic drainage tools and FDOT drainage components 

• Delivered features and components within the FDOTCONNECT Drainage DGN library 

• Laying out a simple network of inlets, pipes, and an outfall 

• Tools to evaluate and edit drainage properties 

• Creating a custom drainage feature 

• Creating and assigning catchments to inlets 

• Tools to define drainage design priorities and constraints 

• Tools to review and evaluate hydraulic performance 

• Producing a NexGen drainage structures sheet 

• Producing a NexGen Summary of Drainage report (drainage quantities) 

• Editing and exporting flex tables for drainage documentation 

Audience 

 FDOT Drainage Designers and Engineers 

Prerequisites 

Participants need to have a basic understanding of Computer Aided Drafting and Design (CADD) using 

MicroStation, a basic understanding of OpenRoads Designer CONNECT Edition - OpenRoads Technology tools 

and a solid understanding of the engineering necessary to design drainage improvements on a Roadway.  

Duration: 16 Hours   

Professional Credit Hours:  16 PDHs 

Note PDH Credits will only be available with Instructor lead or Computer Based Training (CBT) thru Learning 
Curve. 
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FDOT CONNECT WORKSPACE OVERVIEW  

This course was developed to introduce the Drainage and Utilities Workflow and OpenRoads Designer 

CONNECT Edition tools for drainage design and modeling on Florida Department of Transportation (FDOT) 

projects. The curriculum was developed within the FDOTCONNECT Workspace to provide sample exercises 

for many of the Drainage Tools on a sample project data set. 

INTRODUCTION  

OpenRoads Designer CONNECT Edition - Drainage and Utilities Workflow is a comprehensive application for 

designing and analyzing storm drain systems, which can leverage many roadway design features to create a 

seamless information exchange to the drainage design process. A Drainage model may contain multiple drainage 

network and scenarios; each comprised of any number of topologically connected drainage areas, inlets, pipes 

and ditches. The Drainage and Utilities workflow closely mirrors conventional design processes allowing for the 

design of the surface collection system (i.e. drainage areas, inlets) and then the design of the subsequent 

conveyance system (i.e. pipes, ditches). 

OpenRoads Drainage & Utilities is extremely flexible, in that the hydraulics designer can create and manipulate 

elements of the system, while simultaneously seeing the effects. Interactive dialogs and design visualization make 

the process easy to learn and efficiently produce results. Manipulations and redesign are accomplished quickly 

and easily, whether it's moving a single inlet or developing an entire network. At any time during the process, 

customized flex table reports can be generated to provide hard copy outputs. 

Roadway alignments and digital terrain models created as part of the design process may be used throughout 

Drainage & Utilities to provide pertinent information to the drainage design. All drainage components feature 

interactive graphical placement tools for easy spatial definition of the drainage system. Visualization tools in 

OpenRoads Drainage & Utilities for networks, drainage components, and computations allow for immediate 

evaluation of the drainage system. 

OpenRoads Drainage & Utilities hydrologic and hydraulic capabilities include runoff computations, inlet design 

and analysis, and pipe and ditch design and analysis. All computations follow recommended methodologies in 

the Federal Highway Administration (FHWA) publication "Drainage of Highway Pavements" as well as the 

procedures in the American Association of State Highway and Transportation Officials (AASHTO) Model 

Drainage Manual. 

Runoff computations are performed using either the Rational or SCS method where rainfall parameters may be 

specified with common intensity equations, hydrographs, or by tabular intensity-duration data. The Department’s 

Intensity-Duration-Frequency curves are included in the Department’s DGNLib discussed later in this manual. 

Drainage area delineation tools allow easy creation of contributing areas and the graphical assignment of these 

to drainage features. 

Inlet design and analysis capabilities include Curb, Slotted Drain, and Grate inlets both on grade and in a sump. 

The Department’s common inlets are included in the Department’s DGNLib discussed later in this manual. Inlets 

may also be designed or analyzed with gutter bypass flows from one inlet to another, including gutter bypass 

flows between inlets of different networks. 

Most standard pipe configurations may be designed and analyzed including box, circular, elliptical and pipe 

arches. The Department’s most common pipe and box culvert shapes and materials are included in the DGNLib, 

discussed later in this manual. Pipe design selections may be optimized to meet a number of definable constraints. 

Trapezoidal ditches may also be designed or analyzed anywhere within a storm drain network. The pipe and ditch 

hydraulics include backwater curve computations and junction loss options. 

Participants of this course will be introduced to the newest OpenRoads environment and a Workflow for 

designing two dimensional (2D) Plans, Profiles, and three dimensional (3D) Models for drainage related 

Construction Deliverables. At successful completion they will have learned about: 

• Finding additional learning resources and training materials for OpenRoads Designer CONNECT Edition 

and the general process using Drainage and Utilities Workflow to design storm drain systems 

• Various file types used within the Drainage and Utilities Workflow 
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• How to create and prepare a drainage file for design 

• Navigating the interface for basic drainage tools and FDOT drainage components 

• Delivered features and components within the FDOTCONNECT Drainage DGN library 

• Laying out a simple network of inlets, pipes, and an outfall 

• Tools to evaluate and edit drainage properties 

• Creating a custom drainage feature 

• Creating and assigning catchments to inlets 

• Tools to define drainage design priorities and constraints 

• Tools to review and evaluate hydraulic performance 

• Producing a NexGen drainage structures sheet 

• Producing a NexGen Summary of Drainage report (drainage quantities) 

• Editing and exporting flex tables for drainage documentation 
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EXPECTATIONS – WHAT THIS COURSE PROVIDES 

This course serves three primary functions. It is a training manual for instructor lead training, a user's manual for 

designers and technicians, and a technical reference. 

The Florida Department of Transportation (FDOT) standards for drainage design are provided in the Drainage 

Manual. Guidelines for drainage design are provided in the Drainage Design Guide. The FDOT Design Manual 

and CADD Manual provide the standards for preparing the construction plan sets. Suggestions or preferred 

approaches for how to best use the Drainage and Utilities Workflow tools to comply with the Department’s 

CADD standards and guidelines are included in this document, where appropriate. Although this course 

references key tools in the drainage design and plans preparation process for FDOT projects, it does not replace 

the need for professional engineering judgement or prelude the use of other information.   

This course provides a standard workflow for drainage design with Bentley Systems OpenRoads Designer 

CONNECT Edition – Drainage and Utilities Workflow within the FDOTCONNECT Workspace. While many 

tools are used throughout, this course does not provide a description of every Bentley Systems OpenRoads 

Designer CONNECT Edition Drainage and Utilities tool. Where applicable, this guide documents supplemental 

descriptions of FDOT-specific content, tools, and methodology. 
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DOCUMENT STYLE  

Style conventions used throughout the course guide are shown in the following table. 

Item Convention Example 

Menu names and 

commands 
Bold N 

(Names separated with > 

symbol) 

• File > Open 

• File > ComSelect > Design 

Dialog box Actions Bold • Click the Apply button. 

• Click the Graphic Select button to the right 
of the Horizontal Alignment Include box. 

• In the Segment Type list, click Lines. 

Dialog box Field 

Names 
Italic • Key in Hemfield Road in the Alignment 

Name field. 

• Click the Graphic Select button to the right 
of the Horizontal Alignment Include field. 

• In the Segment Type list, click Lines. 

Key-ins Bold • Key in Hemfield Road in the Alignment 
Name field. 

File Names Italic • Open the file  ALGNRD01.dgn in the 
C:\WorkSets\FDOT\22049555201\Roadway. 

File Paths Non italic • Open the file  _Blank.dgn in the 
C:\WorkSets\FDOT\22049555201 

New Terms or 

Emphasis 
Italic • The Template Library contains templates, 

which represent typical sections of the 
proposed roadway. 

 

Additionally, a new workflow terminology using the Ribbon is used throughout the course guide.  If you see a 

direction like this:   

DRAINAGE AND UTILITIES > LAYOUT > LAYOUT > Place Node 

This means we are in the WorkFlow of Drainage and Utilities which has a Tab named Layout and has tools 

that are located in the Layout Group. Now that we are in the right workflow, Tab and Group we may need to 

click on a tool that has more than one option. 
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FILE TYPES 

The Bentley Systems OpenRoads drainage design process now uses a single source file type, the MicroStation 

Design DGN file. All pertinent design data is stored in the design file. This information can be viewed through 

the Project Explorer and reported on through flex tables and other report tools. 

The FDOT Connect Workspace is delivered with supporting library files containing the Department’s CADD 

standards and hydraulic seed data: the DGN Library (*.dgnlib), and the MicroStation Cell Library (*.cel). Below 

are brief descriptions of these file types.  

File Type Description: 

• MicroStation Design File (*.dgn) - This file is utilized for the visualization of the drainage project and 

definition of certain drainage features using MicroStation graphic elements. When the designer initiates the 

Drainage & Utilities tools, the DGN Library hydraulic seed data will be referenced by the design file. 

Subsequently, as drainage components are placed, the. DGN model automatically populates hydraulic 

properties from the DGN Library and drainage structure geometry from the Cell Library into the design file. 

All the design data is stored within the design dgn file and database attributes are attached to the 2D graphics. 

As the designer places components in the 2D model, Drainage & Utilities creates the 3D model elements in 

the dgn simultaneously. 

• DGN Library (*.dgnlib) - The feature definitions, symbology, and hydraulic seed data for drainage design 

and modeling are stored in DGN libraries. The DGN Library is utilized for numerous projects, as it contains 

the standards for an entire organization. The DGN Library contains the storm data, hydraulic settings, 

standard inlet types, standard pipes configurations, spread sections, and land cover tables. These items are 

used by each project to accommodate standardization and information sharing among projects. The 

Department provides a DGN Library with the CADD deliverables.  

• Drainage Cell Library (*.cel) - Drainage cells are the 2D and 3D views of the Department’s drainage 

structures such as inlets and manholes. The Cell Library contains the commonly used structures. The Nodes 

used in the DGN Library refer to appropriate cells in the Cell Library. The Department provides a Cell Library 

with the CADD deliverables. 

Currently, there is not a tool to import legacy Select Series GEOPAK Drainage files directly into an OpenRoads 

drainage model, DGN file from Bentley and FDOT is not developing a utility.   
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LEARNING RESOURCES 

For optimized use of this manual, it is recommended that new OpenRoads users engage with the Bentley 

LEARNserver and Online Help as needed to become familiar with the OpenRoads environment and tools.  

There are several resources available for learning about the various Bentley Systems OpenRoads Designer 

CONNECT edition Drainage and Utilities tools. Among them are: 

• Bentley Learn:  

Bentley Institute site is for registered user and may require a Select Server site license to participate:  

https://learn.bentley.com 

Bentley Product Line: OpenRoads Designer: 

09 – OpenRoads Designer – Drainage & Utilities – Fundamentals 

10 – OpenRoads Designer – Drainage – Intermediate 

• Bentley Product Documentation: Drainage and Utilities CONNECT Edition Help: 

https://docs.bentley.com/LiveContent/web/Drainage%20and%20Utilities%20CONNECT%20Edition%20H

elp-v3/en/GUID-288FAFD8-1107-4FCB-9843-8BECC9099A06.html  

• Bentley Communities: 

https://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/38322/drain

age-and-utilities  

• YouTube Search - Google:   

Bentley OpenRoads Drainage returns several sites with videos for learning how to apply the technology on 

project specific situations. 

• Production Support Office | CADD (CADD) Website:  http://www.fdot.gov/cadd/ 

Webinar training recordings are available on many of the subjects covered in this manual:   

http://www.fdot.gov/cadd/main/FDOTCaddTraining.shtm 

http://www.fdot.gov/cadd/downloads/webinars/Posted.shtm#loadSection 

https://www.youtube.com/channel/UCqbY8kqZuXp1pyYV6lIQw_A 

COURSE SUPPORTING FILES 

The exercises for each chapter are independent of one another and can be used without having to complete the 

exercises in previous modules. The exercise files are organized into separate completed Selected zip files for each 

chapter.  All files used in this course are located also at this link:  

https://www.fdot.gov/cadd/main/fdotcaddtraining.shtm 

  

https://learn.bentley.com/
https://docs.bentley.com/LiveContent/web/Drainage%20and%20Utilities%20CONNECT%20Edition%20Help-v3/en/GUID-288FAFD8-1107-4FCB-9843-8BECC9099A06.html
https://docs.bentley.com/LiveContent/web/Drainage%20and%20Utilities%20CONNECT%20Edition%20Help-v3/en/GUID-288FAFD8-1107-4FCB-9843-8BECC9099A06.html
https://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/38322/drainage-and-utilities
https://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/38322/drainage-and-utilities
http://www.fdot.gov/cadd/
http://www.fdot.gov/cadd/main/FDOTCaddTraining.shtm
http://www.fdot.gov/cadd/downloads/webinars/Posted.shtm#loadSection
https://www.youtube.com/channel/UCqbY8kqZuXp1pyYV6lIQw_A
https://www.fdot.gov/cadd/main/fdotcaddtraining.shtm
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 INTRODUCING A NEW WORKSPACE  

The following are some of the FDOTCONNECT workspace settings that will be used during this course. 

Additional information can be found within the FDOTCONNECT for OpenRoads Designer 2D Design & 3D 

Modeling with Plans Development Training Guide 

FDOTCONNECT FUNCTION KEYS  

FDOTCONNECT Function Key Assignments 

F1 Opens the OpenRoads Designer On-line Help. Ctrl+F1 Closes all Views except View 1 

F2 Open View 1 (2D Plan) and View 2 (3D Isometric) and fits both views. 

F3 Opens View 3 (2D Plan), closes all View 4, and arranges all Views. 

F4 Open View 1 (2D Plan) , View 2 (3D Isometric), View 1 (2D Plan), View 1 (2D Plan) & 

Fits All views 

F5 Toggles Dim References ON/OFF 

F6 Resets out of any ongoing commands. 

F7 Toggles the Construction view attribute ON/OFF. 

F8 Toggles between MicroStation AccuDraw and Civil AccuDraw. 

F9 Toggles (opens or closes) the Reference dialog. 

F10 Toggles (opens or closes) the Level Display dialog. 

F11 Toggles (opens or closes) the Project Explorer dialog. 

F12 Opens the Create Template dialog. 
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FDOTCONNECT DRAINAGE DESIGN AND 3D MODELING OVERVIEW  

GENERAL WORKFLOW 

The design of a storm drain system is usually an iterative process. Inlets locations and pipe sizes are selected. 

The designer checks if the system meets the Department’s criteria and changes pipe sizes and other items as 

needed. The need to check if the system meets criteria is not avoided by using OpenRoads Drainage & Utilities. 

This document describes several ways that designers can use Drainage & Utilities to check and identify where 

the system need to be changed. The following is a general outline for creating storm drain systems in Drainage 

& Utilities, detailed in other chapters. 

1. Start New Project file (.dgn) by using the FDOT Create file tool. 

2. Select Inlet Locations and Types from Feature Definitions. 

3. Define Area to each Node. 

4. Link Inlets Together with Pipe (Conduit) Segments. 

5. Identify Hydraulic Run of Pipes and Inlets. 

6. Use Drainage & Utilities to Design System. 

7. Check Design to meet Criteria. 

8. Edit System, Re-compute Hydraulics and Check if Criteria are met. 

9. Add J-structure Bottoms (if appropriate) for Large or Skewed Pipes. 
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10. Print Storm Drain Tabulation Form. 

11. Prepare Construction Deliverables. 

RECOMMENDED MICROSTATION SETTINGS  

Various tools and settings will be used throughout the workshop. Therefore for quick accessibility, several of the 

dialogs are better docked on the sides the MicroStation view.  

GETTING STARTED 

LAUNCHING FDOTCONNECT FOR OPENROADS DESIGNER  

FDOTCONNECT can be launched from the FDOT – Roadway and FDOT – ROW icons located in the 

FDOTCONNECT folder on your desktop.  The first time it is launched, it is important to select the FDOT 

workspace from the workspace dropdown.  

1. Find the FDOT Connect launch icons on your desktop or locate the “FDOTCONNECT” folder 

on your desktop.  

  

2. Launch FDOTCONNECT for OpenRoads Designer by double-clicking one of the FDOT 

icons. Note that your FDOTCONNECT launch icons will vary depending on which Bentley 

Connect Edition platforms you have installed. FDOTCONNECT will create an icon for 

OpenRoads Designer, an icon for MicroStation Connect Edition (MSCE), and an icon for 

OpenBridge Modeler (OBM) depending on which of these applications is present on your 

machine during installation of the Workstation or Client. 

  

 

 

 

 

 

3. In the Workspace/Workset select screen of OpenRoads Designer, select the Workspace 

selection drop-down menu by clicking on “No Workspace.”  
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4. Select “FDOT” from the drop-down menu to select the FDOTCONNECT workspace.  

    

5. From here, you can now create a new WorkSet. This is done by selecting the drop-down menu, 

being sure to select the FDOT’s “0_WORKSET_TEMPLATE” as the workset template.   

   

6. Click “OK” after filling in the Create Workset dialog.  
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7. After creating a new project using the FDOT Workset Template, you can create new files using 

the FDOT Create File tool.  This tool is launched from within the FDOTCONNECT 

workspace, so you must first open a file.  The FDOT Workset template includes a blank 

starting file from which to launch the Create File tool.  

8. From the OpenRoads Designer file open dialog, select “Browse” to browse the contents of 

your new workset. 

 

9. Locate “_Blankfile.dgn” at the root of your workset folder structure. Select this file and then 

select “OPEN” to open it. 

 

10. When the FDOTCONNECT Workspace opens, you can locate the FDOT ribbon by selecting 

the “OpenRoads Modeling” workflow from the menu at the top left of the screen. The FDOT 
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tab is located at the far right of this ribbon.  Select “Create File” to launch the Create File tool 

for creating FDOT project files.   

 

MENU DOCKING 

  

1. Verify that the Civil Message Center tool is already docked on the bottom; if not, select it from 

the General Geometry Task group, dock and unpin.  
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2. Verify that the Project Explorer is docked on the left side; if not, from the Ribbon select the 

Home tab then in the group named primary click on the explorer icon…Or use the F11 function 

key to toggle ON/OFF the dialog. 

   

3. Verify that the Level Display is docked on the right side; if not, from the FDOT-Function Keys 

press F10, dock and unpin.  

 

4. Verify that the Element Information is docked on the right side; if not, this can be brought up 

by selecting Ctrl+I , dock and unpin. 

  

 Many of the dialog settings are stored in user preferences defined in xml data files located in the users 
data folders, i.e. C:\Users\rd964vd\AppData\Local\Bentley\OpenRoadsDesigner\10.0.0\prefs. 
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CREATE A NEW DGN FILE  

1. Open FDOTCONNECT, set the Workspace to “FDOT” and select the Workset – “22049555201_CE”. 

2. Browse to the “_BlankFile.dgn” and open. 

3. On the FDOT Ribbon Tab in the Actions Group, select “Create File.” 

• Discipline = “DRAINAGE” 

• File Group = “Drainage Design Files” 

• File Type = “DRPRRD” 

• File Sequence # = “01” 

• County = “Wakulla” (State Plane Coordinate System = FL83-NF) 

4. Click on the “Create – Open File” button. Close the Create File Dialogue box. 
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NAVIGATING THE DRAINAGE AND UTILITIES WORKFLOW RIBBON 

When the Drainage and Utilities workflow is activated, there are ten tabs that populate the ribbon. The tabs 

are organized to help you find the tools you need to complete a task. Upcoming chapters will further describe 

these tabs and included tools that are commonly used for FDOT drainage design. 

 

The Home tab has six groups. One of the most useful tools for managing the drainage model is Explorer, 

located in the Primary Group. The Project Explorer is docked on the left side or use the F11 function key to 

toggle ON/OFF the dialog. 

NAVIGATING PROJECT EXPLORER FOR DRAINAGE 

As defined in Bentley Drainage and Utilities CONNECT Edition Help,  

The Explorer dialog allows you to manage and control project content. It is a single interface that provides 

browsing function for files, links, items, resources, and sheet indexes. 

• File - used to browse and manage the file content such as models, references, saved 

views, levels, styles, templates, and so on.  

• Items - displays non-graphical business data in a DGN file in hierarchical order.  

• Resources - displays resources used in a DGN file in hierarchical order.  

• OpenRoads Model – displays content in categories such as alignments, terrain 
models, etc. 

• Sheet Index - allows you to manage sheet indexing. A sheet index is an organizes 

and named collection of sheet models from one or more design files.  

• Links tab - used to create or view the linked data.  

• OpenRoads Standards - used to create, edit or review horizontal and vertical 

geometry design standards, feature information, civil cells, annotation, and 
graphical filters. 

The Drainage and Utilities section of Project Explorer is used to manage conduits, drainage areas, nodes and 

profile runs in the model. 

 

Note It is a recommended practice to check the Explorer when first opening a drainage DGN file to understand 
the contents of the file.  

A DGN file without an active or referenced drainage model will appear blank: 



FDOT CONNECT WORKSPACE OVERVIEW ______________________________________ Recommended MicroStation Settings 

16 ©2020 FDOT  FDOTCONNECT for ORD Drainage Workflows 

 

However, once a utility model is created, the Drainage and Utilities section of Project Explorer is organized 

into collapsible lists of elements: nodes, conduits, drainage areas, and profile runs.  

CREATE A NEW UTILITY MODEL 

1. In the DRPRRD01.dgn, click on DRAINAGE AND UTILITIES > LAYOUT > LAYOUT 

> Place Node. 

2. Since this file does not yet contain a utility model, the Place Node tool will not activate. However, the 

following message will pop up, asking if you wish to proceed creating a utility model. Click Yes to this 

prompt and the next. 

 

 

3. Now, this file is ready to place drainage features in the DGN and/or reference drainage models from 

other DGNs.  
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1 DRAINAGE LIBRARY 

INTRODUCTION  

The main focus in this chapter will be on: Reviewing the Drainage Library. 

This chapter will introduce several important components of the Drainage Library in FDOTCONNECT. They 

are: 

• Feature Definitions 

o Symbology 

▪ Levels, cells, materials 

▪ Element templates 

▪ Feature Symbology 

• Hydraulic Seed Data 

o Catalog 

o Prototypes 

o Storm Data 

This chapter will also introduce the user to a new workflow terminology using the Ribbon. If you see a direction 

like this: DRAINAGE AND UTILITIES>COMPONENTS>CATALOG>Catalog>Inlet Catalog, it means we 

are in the WorkFlow of Drainage and Utilities which has a Tab named Components, and has tools that are 

located in the Catalog Group. Now that we are in the right workflow, Tab and Group we may need to click on 

a tool that has more than one option. 

FEATURE DEFINITIONS 

As defined in the Bentley Drainage and Utilities CONNECT Edition help files: 

“Feature Definitions are used to control symbology and define properties of utility elements. There are three 

types of Feature Definition for support of utility workflow: 

• Node Feature Definitions – A variation on civil Point type. It defines information for Utility Nodes, such 

as catch basins, manholes, valves and etc. 

• Conduit Feature Definitions – A variation on the civil Linear type. It defines information for Utility 

conduits of all types, including drainage pipes, pressure lines, cables and ducts.  

• Polygon Feature Definitions – Used to denote area features such as catchments (drainage areas). 

Feature Definitions developed for the most widely used standard FDOT drainage structures, gutters, and pipes 

have been included within the FDOT_SUE_Drainage.dgnlib for the FDOTCONNECT Workspace to be used for 

most FDOT projects. They can be viewed in the Project Explorer > OpenRoads Standards tab: DRAINAGE AND 

UTILITIES > HOME > PRIMARY > Explorer > OpenRoads Standards > Standards >Libraries > Feature 

Definitions. An inventory of available FDOT features is included with the Technical References section of this 

manual. The Workflow to Create a New Feature Definition will be discussed later in this manual.  

As discussed in the File Types section, all project design and modeling data is stored within the design DGN file. 

When users choose a drainage feature to place for the first time, the software loads the DGN Library and copies 

the feature definition and associated properties into the DGN file, both onto the individual drainage feature placed 

and the design file’s OpenRoads Standards. 

For purposes of this course guide, components of feature definitions will be separated into two categories: 

symbology and hydraulic seed data. In the FDOTCONNECT Workspace, both components are stored in the same 

DGN Library file: FDOT_SUE_Drainage.dgnlib.     
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SYMBOLOGY 

The 2D and 3D graphical presentations of drainage features in the design file are built from a series of 

elements defined the DGN library. A description of this series of elements as defined in the Bentley Drainage 

and Utilities CONNECT Edition help files for utility nodes is below: 

• Feature definitions for all node types will link to a series of Feature Symbology’s.  

• Feature symbologist will link to a series of MicroStation Element Templates for symbology and 

presentation.  

• The plan space template will include a 2D cell of user's design. This cell is placed in plan space for all 

plans production activities.  

• The 3D presentation normally points to two templates. The first defines a 3D cell that models the 

physical nature of the top of the node. The second defines a 3D cell that models the physical nature of 

the bottom of the node. The two cells are joined by extruding a slice of the bottom cell upwards to meet 

the top cell. If the top cell is blank, then no extrusion is done and only the bottom cell is placed.  

• The plan, top, and bottom cells will contain various attributed elements to define key points and regions 

necessary for the creation of the node 3D structure, alignment of the 3 cells, defining connection of 

conduits, and defining hydraulic key points. 

 

HYDRAULIC SEED DATA 

In addition to housing drainage symbology information, the FDOT_SUE_Drainage.dgnlib is also the repository 

for the default information and properties necessary for hydraulic modeling. This includes properties assigned to 

individual drainage features as well as global definitions (e.g. storm data). This information is accessed in various 

ways within the OpenRoads Designer environment and is described further in the sections below. 

CATALOGS 

In OpenRoads, Catalogs are an efficient way to reuse common physical definitions for inlets, conduits, and 

gutters. Catalog items can be imported from and exported to engineering libraries. Similar to the symbology 

series of elements that build feature definitions, there are a series of hydraulic components that ultimately 

assign the hydraulic properties to the feature definitions for drainage elements in the FDOTCONNECT 

Workspace. Catalogs are loaded by Prototypes, which are loaded by feature definitions. The 

FDOTCONNECT Workspace has Catalog items defined locally (not synchronized to a library) for inlets, 

gutters, and conduits. These can be accessed from the path:  
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DRAINAGE AND UTILITIES>COMPONENTS>CATALOG>Catalog 

 

 

 

 

 

The catalog windows contain several tabs to define input, design parameters, engineering library connections, 

and notes. Where applicable, notes have been included to clarify input. Though FDOT inlets do not have 

variable opening lengths subject to design, the conduit catalog is built so that automated design selects from 

available standard pipe sizes 
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Note These parameters are needed for typical FHWA HEC-12 or HEC-22 calculations. The values provided 
were determined by the Department’s staff and are felt to be conservative. Users should verify values prior 
to performing inlet and spread calculations with Drainage and Utilities Workflow and OpenRoads Designer 
CONNECT Edition. 
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Note Conduit vs. Gutter: Conduits model system flow that is intercepted by and passed through nodes. Gutters 
model bypass flow along the ground surface between nodes. Open channel ditch shapes are included in 
each catalog with the FDOTCONNECT Workspace. 

 

PROTOTYPES 

In OpenRoads, Prototypes are similar to Catalogs, but contain additional parameters used for design & 

analysis and are loaded directly by feature definitions. Prototypes are not able to be imported or exported. 

Where possible, the FDOTCONNECT Workspace Prototypes load the respective Catalog. 

FDOTCONNECT Prototype items include inlets, manholes, outfalls, headwalls, gutters, conduits, and 

catchments (drainage areas). These can be accessed from the path: DRAINAGE AND UTILITIES > 

COMPONENTS >CATALOG>Prototypes. 

 

Note Changes to the prototypes are not retroactive and will not affect any elements created prior to the change. 
This also applies to changes in feature definitions; though symbology will change if a feature definition is 
switched after placement, hydraulic properties are applied automatically only once, during initial placement. 
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STORM DATA 

The OpenRoads environment has a variety of options available for assigning wet weather flows to drainage 

models. Storm data can be accessed from the path: DRAINAGE AND UTILITIES > COMPONENTS > 

COMMON>Storm Data>Storm Data. 

For typical rational method calculations on the Department’s projects, the Drainage Manual requires use of 

National Oceanic and Atmospheric (NOAA) Atlas 14 Rainfall Data. In the FDOTCONNECT Workspace, 

User Defined IDF Tables are set up with a blank IDF table intended for user input from project-specific 

NOAA Atlas 14 data.  

 

The Absolute Intensity IDF Table includes a constant 4 in/hr intensity for spread analyses. 

For reference only, the Department’s 11 Intensity-Duration-Frequency (IDF) curves are included through 

regression equation constants and coefficients. Each curve is associated with a certain zone of the state.  

The third-degree polynomial equation provides the best curve fit of the actual data and should not be 

edited.  

There are, for special occasions, several other Storm Types supported in OpenRoads.  

Note Not all the forms of storm data are compatible with all of the hydrology methods in the model. Refer to 
Bentley Product Documentation for further information. 
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EXERCISES 

EXERCISE OVERVIEW – EXISTING FEATURES ORD  

1.1 Explore Properties in Feature Definitions 

1.2 Review and Create a New Catchment Prototype 

1.3 Populate the IDF Table with NOAA Atlas 14 Data and Set the Global Storm Event 

Exercise 1.1 Explore Properties in Feature Definitions 

In this exercise, the user will open the Properties dialog of a drainage feature definition from the DGN Library 

and identify the associated symbology and hydraulic properties. 

 Open FDOTCONNECT, set the Workspace to “FDOT” and select the Workset – “22049555201_CE”. 

 Browse to the drainage folder and open “DRPRRD01.dgn”.  

 Use the Explorer Dialog (Function Key F11) if you do not have it docked. Navigate to the OpenRoads 

Standards Tab then click on Standards to expand list. The list contains loaded DGN Libraries and the 

current file you are in. 

 Navigate through the following path and right-click to open the properties of the feature definition for a 

Type 2 Curb Inlet: Libraries > Feature Definitions > Feature Definition (FDOT_SUE_Drainage.dgnlib 

(Default)) > Node > StormWaterNode > Drainage Structures > Curb > InltCurb2. 

 

 Items in grey are read only. 

 Reviewing the feature definition properties dialog from top to bottom: 

a. Feature Definition category includes name, description, and the name seed. When this inlet is 

placed, the prompts will prefill the name input with ‘S-’. 
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b. Item Type assigned to this type of structure is ‘DrainageInlet’. Item types are used for FDOT 

quantity reports and will be discussed in more detail later in this course guide. 

c. Node definitions include default height, use slope of surface, structure type, and network type. 

The default height value controls the minimum distance allowed between the top and structure 

invert elevations. 

d. The Hydraulic Prototype input indicates that when a Type 2 Curb Inlet is placed, the 

hydraulic properties will be assigned from the ‘Inlet Curb 2’ prototype. 

e. User Data Extensions are defined for some FDOTCONNECT drainage features. These are 

flex tables used in plans and drainage design documentation. Flex Tables and User Data 

Extensions will be discussed in more detail later in this course guide. 

f. Symbology for nodes include point, connection region, and solid. The point feature 

symbology controls presentation of the node in plan view and the solid feature symbology 

controls 3D presentation.  
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Exercise 1.2 Review and Create a New Catchment Prototype 

In this exercise, the user will review available land cover definitions provided with the FDOTCONNECT 

Workspace and learn how to create a new catchment prototype for project-specific use. Custom prototypes may 

be useful if project drainage areas have a consistent C value that are not reflected in the predefined land covers.  

 Navigate through the following path to open the list of catchment prototypes and open properties for 

Pavement: DRAINAGE AND UTILITIES>COMPONENTS>CATALOG>Prototypes>Hydraulic 

Analysis >Catchment>Pavement. 
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 Since this is a prototype, settings shown in this Properties dialog are applied by default to new 

catchments with feature definition = Pavement. For Pavement, the assigned C value is 0.95. Time of 

Concentration is set to user defined, which can be assigned after placement. Close the properties dialog. 

 Right click Catchment in the Prototypes dialog and select ‘New’. Double click to open the newly created 

‘Catchment Prototype – 1’  

 

 Reviewing from top to bottom, the following are sample settings for a project-specific mixed land 

cover: 

a. Change Use Scaled Area to True 

b. Change Runoff Method to Rational Method 

c. Change Area Defined by to Multiple Subareas 

 

d. On the Subareas line, click on the ellipse to open <Collection: 0 items>. 

i. Select ‘New’ twice to add two lines to the collection table and enter Description and 

Runoff Coefficient as shown below, or as appropriate for project-specific settings. 

ii. Click ‘OK’ to close the dialog. Now, the Subareas line should read <Collection: 2 items> 

 

e. Close dialogs. 

 

Note There is currently not a workflow for automated delineation of subareas and computation of composite 
Rational C Coefficient. Recommended workflows for delineation are discussed later in the next chapter.   
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Exercise 1.3 Populate the IDF Table with NOAA Atlas 14 Data and Set the Global 

Storm Event 

In this exercise, the user will review where to obtain and enter project-specific NOAA Atlas rainfall data and set 

the global storm event for the Base Rainfall Runoff alternative. Alternatives will be further discussed later in this 

manual.    

  Navigate through the following path to and select the User Defined – NOAA Atlas 14 IDF Table: 

DRAINAGE AND UTILITIES>COMPONENTS>COMMON>Storm Data>Storm Data>User Defined 

IDF Table > User Defined – NOAA Atlas 14.  

 

 

 By default, the table is empty and set up to receive intensity data for durations 5-min to 24-hr and 1 Year 

to 500 Year storms.  

 From the Department’s Drainage Manual, Section 1.4, open the hyperlink to the NOAA Atlas 14 Rainfall 

Data.  

 

 Enter project location information and make the following selections within the NOAA web page: 

a. Data type = Precipitation intensity 

http://hdsc.nws.noaa.gov/hdsc/pfds/pfds_map_cont.html?bkmrk=fl
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b. By location = Latitude 30.107805 and Longitude -84.379975 and Submit. 

 

 At the bottom of the data table, select Submit to generate the CSV file. 

 

 Open the CSV file and copy the following range of data: 5-min to 24-hr and 1 Year to 500 Year: 
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 Back in OpenRoads, click on the upper left of the table, the cell for 5-min, 1 Year, and Ctrl-V to paste 

the rainfall data. The completed table is shown below. Close the dialog when finished. 

 

 Open Global Storm Events, from the path DRAINAGE AND UTILITIES>COMPONENTS> 

COMMON >Storm Data>Global Storm Events. 

 

 Click the down arrow in the white cell beneath Global Storm Event heading to expand the list of available 

FDOT storms. Select User Defined – NOAA Atlas 14 – 10 Year, near the bottom of the list, and close 

the dialog box.  
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2 LAYOUT TOOLS & PROFILE RUNS 

INTRODUCTION 

The main focus in this chapter will be on: Reviewing the Layout Tools. 

This chapter will introduce several important tools and features available in the Drainage and Utilities Workflow 

and FDOTCONNECT Workspace to build a drainage network. They are: 

• Place Node 

• Place Conduit 

• Place Gutter 

• Place Catchment 

• Profile Runs 

This chapter will also introduce the user to a new workflow terminology using the Ribbon. If you see a direction 

like this: DRAINAGE AND UTILITIES>LAYOUT>Layout>Place Node, it means we are in the WorkFlow of 

Drainage and Utilities which has a Tab named Layout, and has tools that are located in the Layout Group. 

Now that we are in the right workflow, Tab and Group we may need to click on a tool that has more than one 

option. 

PLACE NODE 

Nodes are used to define drainage structure points within a drainage network. Nodes include all the Inlets, 

Junctions, and Outlets in the network and provide for the connectivity of the Conduit system. Nodes are also used 

to indicate physical changes in Conduit sizes or slopes. Conduits cannot change size or slope, other than at Nodes. 

The general workflow includes a series of steps that are prompted by the Place Node tool to define the parameters 

for elevation, location, and rotation.  

 

Workflows include the following, as defined in Bentley Drainage and Utilities CONNECT Edition Help: 

Select Reference Element for Node Elevation. Reset to Type an Elevation - pick the element 

that you want to use to define the top elevation of the node. This can be a linear element which 

has an active profile, a mesh, or a terrain model. The elevation normally represents the top of 

the cover for a chamber. Press Reset if you want to enter an elevation.  

Define Location - define a point to locate the node (by clicking in the graphics, Civil AccuDraw, 

or snapped to other graphics). Note that the text of the prompt tells you the type of node being 

place, such as Place Manhole for example. If you chose a reference element in the previous 
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prompt, then this prompt lets you define a vertical offset from that element. If you pressed Reset, 

then this prompt lets you type in an elevation.  

Select Rotation Mode - choose whether you want to define the rotation of the node using an 

absolute value, or relative to an alignment (which can be any linear element).  

If you choose Absolute, then next prompt is to Select Rotation or Reset to Place again. 

The rotation is defined as an absolute value, using the settings defined in File > Settings 

> File > Design File Settings > Angle Readout. If Civil AccuDraw is used the define the 

location of the node, then the compass will lock to the nearest compass point, which is 

defined in the Civil AccuDraw Settings. The rotation value is still absolute -it will not 

update if the element selected in Civil AccuDraw Station and Offset is subsequently 

modified.  

If you choose Relative to alignment, then the next prompt is to Locate Reference Element 

for Rotation. Select a linear element, from the active design file or a reference. The next 

prompt is to Select Rotation or Reset to Place again. The rotation value is relative to the 

selected linear element, and will be updated if the element is subsequently modified.  

Feature Definition - Defines the feature definition to be assigned to the new node.  

Name Prefix - the feature definition provides a default naming prefix, which can be overridden 

here.  

Node placement is one of several steps in the FDOT drainage design and modeling process. After placement, 

nodes may require additional input from the designer within the Element Info and Quick Properties dialogs.  

Nodes created in drainage models can be managed through Project Explorer, from the following path: 

DRAINAGE AND UTILITIES>HOME>PRIMARY> Explorer> Drainage and Utilities Model > (dgn file) > 

Nodes. 

PLACE CONDUIT 

Conduits connect and convey intercepted runoff from the various Nodes within a network to the Outfall, and may 

consist of pipes, boxes, or ditches. A multitude of options for sizing, and profiling Conduits are supported.  

A Conduit represents a linear feature depicting a path connecting two Nodes. The path may be a straight line, line 

string, curvilinear, or a combination and series of linear MicroStation elements and should be placed from 

upstream to downstream. 

The tool is accessed from the path: DRAINAGE AND UTILITIES>LAYOUT>Layout>Place Conduit. 
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As defined in Bentley Drainage and Utilities CONNECT Edition Help, 

The characteristics of the Place Conduit command are:  

• Utilize a feature definition which defines conduit characteristics  

• Will create the conduit to connection points defined in the nodes  

• Will model the conduit in 3D 

Elevations at the conduit ends are determined as follows:  

1. The Conduit Feature definition for a utility (non-hydraulic) line contains a 

minimum depth of cover property, in the conduit table. For a drainage (hydraulic) 

conduit, the depth of cover is read from the Default Design Constraints, unless this 

is overridden in the prototype for the Conduit Feature Definition, by changing Set 

Local Design Constraint to True, then specifying the minimum depth of cover there. 

The minimum depth of cover will result in an elevation at the end points. If Consider 

Cover Along Pipe Length is checked on in Default Design Constraints, then the 

minimum depth of cover will be adhered over the whole length of the pipe - not just 

at the end points.  

2. If you enter a slope on second prompt the slope may result in an elevation on the 

second node which is different than the minimum depth of cover for the conduit or 

the node cell.  

3. The nodes will have an invert elevation point defined in the bottom 3D cell. This is 

the elevation that will be used in absence of other information. 

PLACE GUTTER 

Gutters are required to model bypass flow along the surface between nodes. Typical applications of gutters in 

FDOT designs are Curb & Gutter, median and adjacent barriers, and shoulder gutter. These are included as feature 

definitions with the FDOTCONNECT Workspace and are available when the Place Gutter tool is activated. 

The tool is accessed from the path DRAINAGE AND UTILITIES>LAYOUT>Layout>Place Gutter. 
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As defined in Bentley Drainage and Utilities CONNECT Edition Help, 

Place Gutter is used to define the following hydraulic characteristics of a drainage 

network:  

1. The path of bypass flow between inlets  

2. The shape of gutter between inlets.  

There is no relationship between the hydraulic definition of a gutter defined with this 

command and the physical model. The hydraulic and physical characteristics are handled 

separately and independently.  

When the tool is started there is a check made to determine if Analytic View is turned on. 

It is necessary for analytic view to be toggled on because hydraulic gutter definitions are 

visible only by way of analytic view 

 

Note In the FDOTCONNECT Workspace, the default Drawing Scale for Drainage Design DGN file is 1” = 50’. 
When Analytic view is active, the DGN is best viewed at Full Size 1 = 1.  The drawing scale can be accessed 
at the following path: DRAINAGE AND UTILITIES>DRAW>Drawing Scales> Annotation Scale.   

Analytic View can be toggled on or off by activating View Attributes and the checkbox for ‘Use Analytic 

Symbology. When toggled on, transient information is displayed for designer information but is not intended for 

plans production.  
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Both Gutters and Conduits created in drainage models can be managed through Project Explorer, from the 

following path: DRAINAGE AND UTILITIES>HOME>PRIMARY> Explorer> Drainage and Utilities Model 

> (dgn file) > Conduits. 

 

PLACE CATCHMENT 

Catchments (drainage areas) in OpenRoads may be used to compute peak discharges or to attach computed 

discharge values to Nodes. The physical drainage area boundaries may be delineated using a digital terrain model, 

simply drawn with MicroStation, or keyed in as a total area value. 

The Drainage Library is an integral part of defining and computing discharges for Drainage Areas. With graphical 

definition of the area boundary, runoff coefficients may be assigned from the available land covers include with 

Catchment features definitions in the Drainage Library. 

Intensity values, for the peak discharge computations, are computed based on the time of concentration (Tc) 

assigned to catchments and the Department’s Intensity-Duration-Frequency curves that are part of the 

Department’s Drainage Library. 

The tool is accessed from the path DRAINAGE AND UTILITIES>LAYOUT>Layout>Place Catchment. 
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As defined in Bentley Drainage and Utilities CONNECT Edition Help the Place Catchment Workflow includes 

the following: 

Method - choose the method to describe the boundary of the area: 

• Pick Points lets you pick a series of points (by clicking in the graphics, Civil AccuDraw, 

or snapped to other graphics)  

• Pick shape lets you select a graphic  

• Flood Fill lets you pick intersecting graphics  

Select Outflow - pick the node that the catchment outflows to, or Reset if this element has not 

been created.  

Select reference surface - pick a terrain model if you want a graphic to be created in the 3D 

model (by draping the catchment boundary over the terrain model) or Reset if you do not want 

this.  

Use Scaled Area - if checked, the enclosed area of the boundary will be used. If unchecked, you 

can type in the area to use in the Area field.  

Feature Definition - Defines the feature definition to be assigned to the new catchment 

 “Design intent builds associations and relationships between civil elements. Object information 

(how, where, and by what method it was created) is stored with the object to insure the original 

intent is retained and honored in the design. If an element is modified, any related elements will 

recreate themselves based on these stored relationships. 

Note In OpenRoads, although automatic subarea delineation is not currently available, multiple catchments may 
be assigned to a single node. For typical FDOT projects, where a combination of impervious and pervious 
areas is collected by an inlet, there are several workflows available to users including: 1). Place a single 
shape catchment that represents multiple land covers and input the Percent (%) of each land cover in the 
catchment properties. 2.) Place multiple shapes and catchments to represent multiple land covers. Use 
available feature definitions such as grass or pavement. The flood fill method may be useful with this 
approach. 

 

PROFILE RUNS  

A Profile is a path between two nodes, spanning one or more links. This chapter will cover creation of profile 

runs. Analysis and plans production uses of profile runs for FDOT projects will be discussed in later chapters.  

The tools are accessed from the path DRAINAGE AND UTILITIES>LAYOUT>Profile Runs>. 
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As defined in Bentley Drainage and Utilities CONNECT Edition Help, there are several methods available to 

create profile runs: 

Hydraulic Run From Node - Creates a profile run from a selected node to the outfall, or between 

two selected nodes. This tool only works on hydraulic (i.e. storm or sanitary) networks.  

Hydraulic Runs to Outfall - Creates a profile run for every path, from the most upstream nodes 

to the outfall. These paths are sometimes known as trunks or branches. This tool only works on 

hydraulic (i.e. storm or sanitary) systems.  

Utility Run From Links - Creates a profile run from selected links, for any type of utility (e.g. 

storm, communications, electric, etc.) The links must be consecutive, without gaps between them.  

Project Run - Projects a profile run created using the tools above onto a linear element, which 

could be a road centerline, or another profile run.  

Profile Runs created in drainage models are managed through Project Explorer, from the following path: 

DRAINAGE AND UTILITIES>HOME>PRIMARY> Explorer> Drainage and Utilities Model > (DGN file) > 

Profile Runs 

 

EXERCISES 

EXERCISE OVERVIEW – LAYOUT TOOLS & PROFILE RUNS 

In this chapter exercise, users will create a simple drainage network. The existing terrain, proposed Centerline of 

Construction and SR61 roadway models will be added as references. Display settings will be adjusted to aid 

identification of drainage patterns. An inlet, a manhole and an outfall will be placed and connected into a drainage 

network. 

2.1 Attach references, set active terrain 

2.2 Set view, display, window settings 

2.3 Review tools to identify drainage patterns 

2.4 Review Civil Accudraw 

2.5 Place Node with Civil Accudraw. 

2.6 Place Node (Outfall, no Civil Accudraw) 
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2.7 Place Conduit 

2.8 Evaluate placed nodes and conduit, adjust elevations 

2.9 Place Catchment 

2.10 Create Profile Run 

2.11 Place Gutter 

2.12 Create a J-Bottom drainage structure Feature Definition 
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Exercise 2.1 Attach References and Set Active Terrain  

 Open FDOTCONNECT, set the Workspace to “FDOT” and select the Workset – “22049555201_CE”. 

 Browse to the drainage folder and open “DRPRRD01.dgn”. 

 Navigate through the following path to open the References dialog and attach the files listed below: 

DRAINAGE AND UTILITIES>HOME>PRIMARY>Attach Tools> References>Tools>Attach: 

a. Survey folder: GDTMDR01.dgn.  

 

i. If prompted, select OK to the alert shown below.  

 

b. Drainage folder: PDPLRD01.dgn 

c. Roadway folder: ALGNRD01.dgn, MODLRD_Mainline_61.dgn, 

MODLRD_Details_61.dgn, DSGNRD01.dgn 
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 Select Fit View to reset window extents to new references.  

 

 Click on the outer perimeter of the existing terrain in the GDTMRD01.dgn file and hover over the 

perimeter to activate the pop-up menu. 

 Click on the middle icon in the pop up menu to Set as Active Terrain Model. 
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Exercise 2.2 Set View, Display, Window Settings  

 Next, move the mouse over to blank space in View 1, hold down the right mouse button to open the 

quick menu for display, and select View Control > 3 Views Plan/Profile/3D. 

 

 The views will automatically orient Plan View in top left, 3D View in top right, and Profile View along 

the bottom. The ‘Open a Dynamic Profile View’ window also pops up. 

 

a. Click OK and follow the prompt to Locate Profile Element. Zoom into the plan view and select 

the alignment for SR 61, as shown below.  
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b. Next, move cursor to profile view and left click to accept the prompt ‘Select or Open View’. 

 

c. As shown below, the proposed profile along SR 61 is populated in the bottom profile window 

and the corresponding alignment in plan view is highlighted teal with arrows for direction of 

profile. 
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Exercise 2.3 Review Tools to Identify Drainage Patterns 

In this exercise, the user will review a sample of tools available to designers for use in delineation of drainage 

areas. Refer to Learning Resources for information on additional tools and OpenRoads features.  

 Profile Reports 

a. Click on and hover over the proposed profile, CL_SR61 to activate the quick menu. Select the 

Profile Report icon from the quick menu. 

 

b. From the Bentley Civil Report Browser, select VerticalAlignmentReview.xsl from list on the 

left. 

c. Review this report in the vicinity the SR 61 and US 98 intersection. See VPI at STA 699+99.14 

with a high point elevation of 35.24, a vertical high point (VHP) at STA 711+79.56, elevation 

35.63, and a vertical low point (VLP) at STA 706+49.68, elevation 31.65. Close the report 

browser. 

 Terrain Display 

a. Another visualization tool is in the 3D view on the terrain itself. Expand the 3D view and click 

on the down arrow to expand the view attributes tool, located at the top left of the window. 

Click and turn on Level Overrides. Close the dialog. 
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b. Next, click on and hover over the boundary of the proposed terrain.to activate the quick menu. 

 

c. From the quick menu scroll down to Calculated Features Display, Source Features Display, and 

Reference. Note, read only attributes are greyed out.  

 

d. Under Reference, change Override Symbology to Yes. Attributes from Calculated Features 

Display and Source Features Display are now available to edit. For example, change Flow 

Arrows to On. Close properties window and review the 3D terrain display. 

 Analyze Trace Slope 

a. The final tool review in this exercise is at the following path: DRAINAGE AND 

UTILITIES>HOME>MODEL ANALYSIS>Civil Analysis> Analyze Trace Slope. Activate 

the tool. 
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b. For this exercise, select Maximum Slope Trace method, with Minimum Depth set to 0.50 and 

Trace Slope Direction set to Down. Under Feature, find and select the Trace Slope feature 

definition. You can enter a name for this feature or use the default. 

 

c. Follow the prompt to select the terrain model element. This is done by selecting the boundary 

of the terrain. 

 

d. Follow the next prompt in the lower corner of the screen, Select a Start Point for Trace Path.  

 

e. The resulting path is the steepest descent from the point selected through the terrain model that 

terminates at the low point. In the sample shown below, a yellow path originates at the point 

selected, and the green polygon represent the low point location. 
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Exercise 2.4 Review Civil Accudraw 

 Reset the view controls to 2 Views Plan/3D, (hold down right-click in the plan view, navigate to View 

Control, select 2 Views Plan/3D). 

 Navigate to DRAINAGE AND UTILITIES>LAYOUT>Toggles> Civil Accudraw and click to toggle 

on. The Civil Accudraw menu can be docked, and when expanded looks like the following: 

 

 This tool is useful for designers when placing drainage features using precise input. Hover over the icons 

for descriptions of each. The upcoming exercise will demonstrate use of Accudraw with Station-Offset.  

Click the Station-Offset icon to activate. 

 

Exercise 2.5 Place Node with Civil Accudraw 

The processes followed in this exercise will result in a node location that automatically adjusts to changes in 

alignment or terrain elevation to maintain the relative horizontal and vertical placement properties.  

 Navigate to DRAINAGE AND UTILITIES>LAYOUT>Layout> Place Node and click to activate tool. 

The tool may open by default with the following window and a prompt for ‘Select Reference Element 

for Node Elevation’: 

 

 Before following plan view prompts, update the dialog with the following: 

a. Check the Vertical Offset box and enter the value 0.001. This is a temporary work-around for 

FDOT structure elevation to properly align with the top mesh surface.  

Note, the Place Node dialog only displays this value to the hundredth. 

b. Change rotation mode to Relative to alignment.  

c. Select the FDOT Curb Inlet Type 2 feature definition from the pull-down menu: Node: 

Stormwater Node: Drainage Structures: Curb: InltCurb2. Upon selection, the dialog may 

expand to show the DrainageInlet Item Type attributes. FDOT Drainage Item Types will be 

discussed in a later chapter. 
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 Now that the dialog is set up, follow the prompts to place the curb inlet. The current prompt is Select 

Reference Element for Node Elevation. With the 3D view open, move the cursor over to the 3D model 

and left click on the edge of the proposed terrain.  

 

 If an OpenRoads tool is prompting the user for additional input, the specific prompt can usually be seen 
both on the cursor and in the messages located in the lower left of the OpenRoads window. 

 The next prompt is Define Catchbasin. This exercise will not choose to activate this option, left click to 

move on to next prompt. There are available workflows within OpenRoads tools to automatically place 

catchbasins, assign to node, and update based on terrain properties and node locations. Refer to Bentley 

Product training and online help for further details. The FDOT sample exercises will place the node and 

catchbasin features separately.   

 Since Civil Accudraw – Station-Offset was activated when we initiated the place node tool, the cursor 

prompts now include the following fields for Station and Offset:  

 

 Use the tab button to cycle through the prompt fields so that Offset is active and type in ‘o’ (for ‘origin’). 

The tool prompts change to ‘Select a reference element or reset to return to command’. Move cursor 

back to plan view and select the centerline alignment CL_SR61.   
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 Now, the node placement is associated with the project alignment. Moving the cursor dynamically 

updates the tool display of Station Offset. Use tab to cycle to the Station line and enter 70650.00. Tab 

to the Offset line and enter 40.0. This has ‘locked in’ the location of the curb inlet to STA 706+50, 40’ 

RT. 

 

 The next prompt is Select Rotation Mode. In the earlier setup, we selected Relative to alignment. Left 

click to accept this mode and the next prompt is to select the element that defines the node rotation. 

Select the CL_SR61 alignment from Step 6 and enter S00°00’00”E in the Rotation field. 

 After accepting settings, the program takes some time to process. This is normal when placing a new 

node type for the first time. Left click to exit the place node tool. Next we will explore and update 

properties of the node just placed. 

 With the plan view active, open References dialog and turn off the 3D model. This can make it easier to 

isolate the 2D linework. 

 

 Select the node. Since this was placed using Civil Accudraw, Station-Offset, the location is locked along 

these parameters, but may be edited with the orange label and dimension manipulators. For example, 

click on the 40.00’ dimension and type in 100.00 in the text box and enter. The structure location is 

automatically moved to 100.00’ RT offset. Test changing the station to a new location and when done, 

relocate the node to original STA 706+50, 40’ RT location. 
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 With the node selected, hover over the node linework and open the center icon from the quick menu, 

Utility Properties.  

 

 The Utility Properties contain two tabs: Subsurface Utilities and Hydraulic Analysis, shown side by side. 

Most of the properties have been automatically loaded based off the feature definition and prototype. 
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Note Feature Definition and Prototype properties used for drainage nodes, conduits, and catchments are one-
time and one-way. For example, if a prototype is edited after a node is placed, those edits will not be 
reflected in the node properties. Conversely, if edits are made to a placed node, this has no effect on the 
prototype or feature definition. 

 In each tab, the References sections, the Baseline, Station, Offset information is either blank or zero. For 

these location properties to be associated to individual drainage features in the model, there is another 

workflow that is needed and can be performed individually or with multiple features simultaneously. 

a. Close the Utility Properties. With the node still selected, open the element properties. Scroll 

down to the Utility section and see that Station/Offset Reference is ‘None’.  
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b. Click the ellipse and follow the prompts to define the reference baseline. Select the same 

alignment used for node placement, CL_SR61. 

 

c. To verify this has taken effect, unselect & reselect the node. Reopen the utility properties and 

check the References section. Close the properties dialogs. 



Chapter 2 LAYOUT TOOLS & PROFILE RUNS ___________________________________________________________ Exercises 

FDOTCONNECT for ORD Workflows ©2020 FDOT  2-23 

 

Note If the Station/Offset Reference (alignment file) is turned off or detached, the corresponding Station and 
Offset fields may not report correctly. If Station / Offsets are reporting 0+00 and 0.00, follow steps 11a. and 
11b to reestablish the link. This can also be accomplished with a selection set.  

 Before we move on, let’s explore another way to access the node properties. Navigate to this node in 

Project Explorer: DRAINAGE AND UTILITIES>HOME>Primary > Explorer > Drainage and Utilities 

Model > DRPRRD01.dgn > Nodes . 

 Right click on the node, ‘S-‘ to expand the tools available for nodes in Project Explorer. Rename this 

node to S-101. Node names can be set during placement in the place node prompts or renamed 

subsequently in Project Explorer.  
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Exercise 2.6 Place Node (Outfall, no Civil Accudraw) 

In Exercise 2.5, the node was placed with horizontal properties dependent to a roadway alignment. In this exercise, 

the node location is not dependent on an alignment, and would not change if the roadway alignment were updated. 

However, the node rotation would update automatically for changes in the pond geometry.  

 Navigate to DRAINAGE AND UTILITIES>LAYOUT>Toggles> Civil Accudraw and click to toggle 

off.  

 

 Navigate to DRAINAGE AND UTILITIES>LAYOUT>Layout> Place Node and click to activate tool. The tool may 

open by default with the following window and a prompt for ‘Select Reference Element for Node 

Elevation’. 

 Before following plan view prompts, update the dialog with the following: 

a. Check the Vertical Offset box and enter the value 0.001. This is a temporary work-around for 

the FDOT structure elevation to properly align with the top mesh surface. 

b. Change rotation mode to Relative to alignment.  

c. Select the FDOT Cross Drain Mitered End Section (1:4 slope, single 18” pipe) feature definition 

from the pull-down menu: Node: Stormwater Node: Drainage Structures: Outlet: Mitered End 

Section (Cross Drain): MESC18RCP4S.  

d. Type in the Name Prefix S-102. 

 Now that the dialog is set up, we’ll follow the prompts to place the outlet. The current prompt is Select 

Reference Element for Node Elevation. In plan view, move the cursor over to the pond and left click on 

one of the handles of the pond corridor (the small ticks around the top and bottom perimeter).  

 

 With the pond surface selected, moving the cursor along the pond side slopes will dynamically report 

the elevation of the surface. Find a location along the pond bottom (blue line) approximately aligned 

with S-101 and left click to select location and advance to the next prompt, rotation.  
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 Select the pond bottom blue line as reference element for rotation. The Rotation angle or bearing will be 

about this line, enter N90°00’00”W. Left click to accept and allow the software to process and place the 

MES. Once complete, right click to exit the tool, which is ready to place the next node. 

 

 The MES is not yet at the desired location. Next we’ll explore and use the manipulators available on the 

node. 

a. Using Element Selection tool, click on the node. The brown dot & arrows and orange text are 

all editable when the node is selected. If the node was initially placed at the wrong rotation, 

overriding the value here is an easy way to fix it.  

  
b. Select the dot at the reference location point and move downward so that the end of the MES is 

aligned with the pond. Left click to accept new location. 

 

 

c. Finally, reselect the node and open the element properties. Scroll down to the Utility section 

and see that Station/Offset Reference is ‘None’. Click in this field and the click the adjacent 

ellipse and zoom out as needed to select CL_SR61. 
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Exercise 2.7 Place Conduit 

 Navigate to DRAINAGE AND UTILITIES>LAYOUT>Layout> Place Conduit and click to activate 

tool. The tool will open by default with the prompt for ‘Select Start Node ’: 

 Before following plan view prompts, update the dialog with the following: 

a. Select the Circular-Concrete feature definition from the pull-down menu: Conduit: Stormwater: 

Drainage Pipes: Circular Pipes: Circular-Concrete. 

 
b. Since the pipe we intend to place is from S-101 (upstream) to S-102 (downstream), type in the 

Name Prefix P-101. 

c. For the Description field, use the pulldown menu to select 18 inch. 

d. Leave the remaining input blank, the completed dialog is shown below: 

 

 Now that the dialog is set up, we’ll follow the prompts to place the conduit. The current prompt is Select 

Start Node. In plan view, zoom towards the curb inlet, S-101 and move the cursor along the connection 

region, shown in dashed orange. Locate an area that is approximately between the center of the structure 

and the MES, S-102 and left click to accept the starting point. 
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 The next prompt is to Select node to make a connection. Since we intend to place a straight pipe with no 

curves or bends towards S-102, we will ignore the <Alt> and <Ctrl> options available in the prompt. 

Move the cursor to the connection region on S-102, left click to accept. 

   

 In the FDOT CONNECT Workspace, default pipe symbology includes arrows to indicate direction of flow 
from upstream to downstream. 

 For pipes, the manipulators are at the ends and may be used to adjust the start or end of pipe. 
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Exercise 2.8 Evaluate Nodes and Conduit in XS and 3D views. Adjust Elevations. 

 So far, the place node and conduit exercises have kept the initial default elevation properties. This 

exercise will show how to view the vertical properties and edit. Activate View Control by holding down 

the right mouse button and select 3 Views Plan/XS/3D. The windows will automatically adjust and 

Select OK to the prompt to Create a Dynamic XS View. 

 

 

a. Follow the next prompt to Locate Corridor or Alignment by selecting CL_SR61. 

b. Fill in the dialog with the settings: Left Offset = 0, Right Offset = 100, Station = 706+50, 

Interval = 10. Left click to accept these settings in the prompts until the Select or Open View 

prompt is active. Click anywhere within the blank window to automatically load the cross 

section. 
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 Since the MES was placed using a 0.00’ vertical offset from the pond surface, the initial pipe invert of 

P-101 defaulted to the elevation of the pond at the node reference point location. However, now that the 

S-102 outlet structures is linked to P-101, when we override the downstream invert to EL 25.00, the 

MES invert elevation will follow.  

a. In plan view, select and open properties for P-101. Type in 25.00 in the Stop Invert field: 

 
b. In cross section view, click in the window to refresh and see updates both to P-101 and S-102 

inverts. 

 

c. Next, verify the change in S-102 by selecting the node in plan view and open properties. 

 

 Finally, in cross section view, zoom in towards the curb inlet, S-101. In plan view, open S-101 properties. 
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a. Invert Elevation 25.95 is the default structure invert elevation assigned to S-101, based on the 

default height defined in the feature definitions. Similar to the default pipe invert assigned at S-

102, the initial P-101 upstream invert matches the structure invert of S-101. The pipe and 

structures inverts are linked to a point. The steps below will demonstrate this. 

i. If the pipe invert is lowered below the structure invert, the structure invert will 

automatically be lowered to match. Select P-101, open properties, and edit the upstream 

invert elevation to 25.20. 

 
ii. However, to allow for pipe thickness, select S-101 and open properties to edit the structure 

invert to 24.20. This time, the P-101 pipe invert, does not follow, but remains at 25.20. 
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Note Refer to Standard Plans Index 425-001 for standard placement of structure bottom relative to pipe.  
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Exercise 2.9 Place Catchment 

 Reset view control to plan view and zoom in towards S-101. Use F5 to Toggle Dim References. Navigate 

to DRAINAGE AND UTILITIES>DRAWING>Placement> Place Shape and click to activate tool. For 

this exercise, draw a polygon from approximately center of median to back of sidewalk (RT) from 

Station 705+00 to 708+00. For this exercise, the active level (the level the preliminary shape is drawn) 

does not matter.  

 

 

 Navigate to DRAINAGE AND UTILITIES>LAYOUT>Layout> Place Catchment and click to activate 

tool. The tool and dialog will open by default with the prompt for ‘Select Layout Method’.  

 

 Before following plan view prompts, update the dialog with the following: 

a. Select the Pavement feature definition from the pull-down menu: Drainage Area: Catchment: 

Drainage Areas: Pavement. By default, this feature will assign a C value of 0.95. 

b. Since the catchment we intend to place drains to S-101, type in the Name Prefix DR-101. 

 

 Follow the plan view prompts, left clicking to accept the settings. 

a. Pick the shape drawn in step 1.  

b. Select S-101 as the outflow. 
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c. <Reset> (right click) to continue picking without reference surface and close tool. 

 Select the shape and hover over the linework to bring up quick menu. Select Utility Properties. 

 

 The input used for hydraulic analysis are shown below. Most properties are inherited from the Pavement 

feature definition, but Time of Concentration needs input.  Enter 10.00 (minutes.) 
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 There’s one more change to DR-101 to better represent the ratio of previous and impervious cover. As 

an alternative to placing separate shapes for different C values, we’re going to edit the properties of DR-

101 to calculate the weighted C value. In the Runoff category, select the pulldown for Area Defined By 

and Select Multiple Subareas. 

 

 In the SubAreas line, click the ellipse next to <Collection: 0 Items> 
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 Enter the following into the Subareas – Catchment (DR-101) window prompted by the ellipse, select OK 

to close the dialog. Close utility properties. 

 

 In OpenRoads, the Drainage and Utilities tables usually represent calculated values in yellow cells and 
editable fields in white cells. 
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Exercise 2.10 Place Gutter 

 Before placing a gutter, use Place Node tool to add S-103, a new curb inlet, Type 1 (RT), at Station 

705+00, 40’ LT. Refer to steps in Exercise 2.5 as needed.  

 

 Next, use Place Conduit tool to add P-103, a new 18” Circular-Concrete pipe, from S-103 to S-101. 

Refer to steps in Exercise 2.7 as needed. 

  

 

 Also, use Place Catchment tool to add DR-103, a new drainage area, from approximately Station 703+00 

to 705+00. Refer to steps in Exercise 2.9 as needed. 



Chapter 2 LAYOUT TOOLS & PROFILE RUNS ___________________________________________________________ Exercises 

FDOTCONNECT for ORD Workflows ©2020 FDOT  2-37 

  

 Navigate to DRAINAGE AND UTILITIES>LAYOUT>Layout> Place Gutter and click to activate 

tool. After selecting Yes to the warning dialog to turn on Analytic View, the tool will open by default 

with the prompt for ‘Select Start Node’ and a change to the view symbology: 

 

 

 Before following plan view prompts, update the dialog with the following: 

a. Select the ‘Between Nodes’ Method 
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b. Select the ‘2 Percent Cross Slope’ feature definition from the pull-down menu: Conduit: 

Stormwater: Gutters: 

c. Since the pipe we intend to place is from S-103 to S-101, type in the Name Prefix Gutter-103. 

   

 Now that the dialog is set up, we’ll follow the prompts to place the gutter. Select S-103 as the Start Node 

and S-101 as the Stop Node.  

 Once placed, select the new Gutter-103 and open properties. By default, the inverts of Structures S-103 

and S-101 are set as Start and Stop Invert of the gutter. Override these elevations to match the surface, 

the structure top elevations shown in the corresponding node properties. 

 

 Close open dialogs. With the gutter placed, the sample network is complete and ready for computations. 

 

  



Chapter 2 LAYOUT TOOLS & PROFILE RUNS ___________________________________________________________ Exercises 

FDOTCONNECT for ORD Workflows ©2020 FDOT  2-39 

Exercise 2.11 Create Profile Run 

 Use view control to select 2 Views Plan/Profile. Select Cancel at the Open a Dynamic Profile View 

prompt. 

 

 Navigate to DRAINAGE AND UTILITIES>LAYOUT>Profile Runs> Hydraulic Run from Node and 

click to activate tool. The tool will open by default with the prompt for ‘Select Start Node ’: 

 

 Before following plan view prompts, update the dialog with the following: 

a. Enter ‘S-101 to S-102’ in the Name field. 

b. Select the Const. Lines Blue feature definition from the pull-down menu: Linear: Roadway 

Design: Plan/Profile 2D Lines: Construction Lines: Const. Lines Blue. 

 

 Follow prompt and select S-101 start node. 

 Select S-102 as Stop Node and left click to Accept Profile Run.  
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 If not already docked and open, click F11 to Toggle Project Explorer, or use following path and navigate 

to profile runs: OpenRoads Standards tab: DRAINAGE AND 

UTILITIES>HOME>PRIMARY>Explorer>Drainage and Utilities>Drainage and Utilities 

Model>DRPRRD01.dgn>Profile Runs. 

 

 Right click on S-101 to S-102 to view the tools available to manage this profile from explorer. 

 

 Select Open Profile Model and follow prompt to Select or Open View by clicking anywhere within the 

blank profile view window below the plan view window. 
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Note In OpenRoads, if a profile is active in a view, the related linework in plan, including direction of stationing 
is shown highlighted in plan view. Stationing in Drainage and Utilities profiles are along the pipe run and 
always start at 0+00.00. 
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Exercise 2.12 Create a J-Bottom drainage structure Feature Definition 

There will be cases where a project needs a variation of a drainage structure that is not provided in the default 

FDOT DGNLib. This exercise shows how to create a new Feature Definition in the DGN design file, by 

copying a similar structure and editing for changes. A Type 2 Curb Inlet with a 5’ diameter J-bottom will be 

created based off the ‘InletCurb2’ (P-bottom) definition. 

To trace how the Symbology links are made in a Features Definition, this exercise is going to start from the 

right side of graphic below, at the Feature Definition and work its way left through Feature Symbology’s and 

Element Templates (Steps 1 - 5).  Finally, the exercise will work from left to right to re-link connections to the 

new symbology’s (Steps 5-6).  

 

 While in the Default or Multi-Model Views in DRPRRD00.dgn, use the Explorer Dialog (Function Key 

F11 if you do not have it docked). Navigate to the OpenRoads Standards Tab then click on Standards to 

expand list. The list contains loaded DGN Libraries and the current file you are in. Expand 

DRPRRD00.dgn. 
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 Expand Feature Definitions and scroll down to Node: Stormwater Node: Drainage Structures: Curb: to 

view all the feature definitions that have been brought into this DGN from the default DGNLib through 

placement of structures. 

 

 Right click on InltCurb2 and select Copy. This will automatically duplicate the feature definition. For 

this example, the new feature is for a Type 2 Curb Inlet with a 5’ diameter J-bottom; rename 

InletCurb2J5Dia. 

  

 Right click on InltCurb2J5Dia and open properties. Review and see properties copied from the P-

bottom definition. It is appropriate for some properties to remain, but some need changes for the J-

bottom. 
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a. Feature Definition: Name, Description, and Name Seed: 

i. Add to Description: “J-Bottom 5’ Dia.”  

b. Item Type: no change needed. 

c. Node: no changes needed.  

d. Hydraulic Prototype: no change needed. 

Note The Physical properties within the Hydraulic Prototypes include structure bottom sizes and dimensions. 
For networks that model losses within structures, it may be appropriate to create a new Prototype for J-
bottom structures. However, for simple drainage networks, the bottom size does not significantly impact 
the hydraulic performance.  

e. User Data Extensions: no change needed. 

f. Symbology: only the Solid Feature Symbology will need changes (see Step 6), but first a new 

symbology is required. 

 Close the properties dialog and navigate back through Explorer and right click to make a copy of the 

InltCurb2 Solid Feature Symbology: OpenRoads Standards: DRPRRD01.dgn: Feature symbology’s: 

Solid: Node: Stormwater Node: Curb:  InltCurb2. Name the new symbology to match the new feature 

definition: InltCurb2J5Dia and right click to open properties. 
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a. The Bottom Template for 3D will need to be updated for a J-bottom structure. Use the pulldown 

menu to select JBot5Dia. 

Note Bottom cells and corresponding Element Templates are available for standard J-bottom sizes. If a special 
structure cell has been added to a cell library, a corresponding Element Template can be created from the 
Manage Templates… dialog. As shown below, Element Templates generally define which cell is used and 
how it is displayed. 

 

 Now that the Solid Feature Symbology is set, re-link the symbology properties in Feature Definitions. 

The feature definition will now be ready to place. 
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Chapter 3 DESIGN AND ANALYSIS __________________________________________________________________ Introduction 

FDOTCONNECT for ORD Workflows ©2020 FDOT  3-47 

3 DESIGN AND ANALYSIS 

INTRODUCTION 

The main focus in this chapter will be on: Drainage Design and Analysis. 

This chapter will introduce several important tools and features available in the Drainage and Utilities Workflow 

and FDOTCONNECT Workspace to design, analyze, and view computation results for a drainage network. They 

are: 

• Default Design Constraints 

• Engineering Standards 

• Scenarios 

o Alternatives 

o Calculation Options 

• Calculation and Analysis 

o Validation and Notifications 

o Compute Center 

o Calculation Summary 

o Flex Tables 

o Analytic Profiles 

In OpenRoads Designer CONNECT Edition, the Drainage and Utilities tools include automatic design 

capabilities including “size conduits, set node invert elevations and determine the size of inlets to pass a design 

storm while meeting user-specified constraints.” For purposes of this chapter, the term ‘Design’ generally refers 

to the various automated design functions in OpenRoads.  

Note ‘Design Considerations’ from Bentley Drainage and Utilities CONNECT Edition help: “As with any 
automated design, the program's design is intended only as a preliminary step. It will select pipe sizes and 
pipe invert elevations based on the input provided, but no computer program can match the skills that an 
experienced engineer has. The modeler should always review any automated design, and should make 
any changes required to adjust, improve, and otherwise polish the system.” 

DEFAULT DESIGN CONSTRAINTS 

When Drainage and Utilities is used for ‘Automatic Constraint Based Design’, the Default Design Constraints 

allow users to define global constraints that are considered in the design algorithm.  

Default Design Constraints is accessed from the path: DRAINAGE AND UTILITIES > ANALYSIS > Analysis 

Tools > Default Design Constraints:  

 

As described in Bentley Drainage and Utilities CONNECT Edition Help: 

Pipe diameters, invert elevations, node structures, and inlets can be all designed with the same set of design 

constraints. You also have the option to adjust these values individually for each pipe or structure.  

The Default Design Constraints dialog is divided into the three following tabs:  
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• Gravity Pipe  

• Node  

• Inlet 

 

In the FDOTCONNECT Workspace, default settings have been assigned where applicable to align with FDOT 

standard practices and criteria. There are also some defaults that will be project-specific, such as Inlet: Maximum 

Spread.  

For additional details on how constraints are evaluated during automated design, see ‘Design Priorities’ topic in 

Bentley Drainage and Utilities CONNECT Edition Help.  

ENGINEERING STANDARDS 

Engineering Standards allow users to assess the model relative to user defined criteria and is accessed from the 

path: DRAINAGE AND UTILITIES > ANALYSIS > Calculation > Engineering Standards: 

 

As described in Bentley Drainage and Utilities CONNECT Edition Help: 

Engineering Standards allow you to define custom validation rules that will generate messages pointing to 

input values in the model that, while they could be computed without causing errors, are not of good 

engineering judgement. 
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Results of the Engineering Standards validation are reported in the Engineering Standards tab within the User 

Notifications Manager. 

In the FDOTCONNECT Workspace, there are no predefined Engineering Standards. PLACEHOLDER: It is 

anticipated this function may be included with typical drainage design documentation to demonstrate various 

FDOT Drainage Manual Criteria are met.  

SCENARIOS 

In the OpenRoads Designer CONNECT Edition environment, Scenarios are used by the Drainage and Utilities 

Model to manage all the data, properties, and settings required to perform hydraulic calculations.  

The Scenario Manager tool is accessed from the path: DRAINAGE AND UTILITIES > ANALYSIS > 

Calculation > Scenarios > Scenario Manager. 

 

As defined in Bentley Drainage and Utilities CONNECT Edition Help, 

A Scenario contains all the input data (in the form of Alternatives), calculation options, 
results, and notes associated with a set of calculations. Scenarios let you set up an unlimited 

number of What If? situations for your model, and then modify, compute, and review your 
system under those conditions. 

You can create scenarios that reuse or share data in existing alternatives, submit multiple 

scenarios for calculation in a batch run, switch between scenarios, and compare scenario 
results--all with a few mouse clicks. There is no limit to the number of scenarios that you 

can create. 

There are two types of scenarios:  

• Base Scenarios—Contain all of your working data. When you start a new model, 

you begin with a default base scenario. As you enter data and calculate your 

model, you are working with this default base scenario and the alternatives it 
references.  

• Child Scenarios—Inherit data from a base scenario, or other child scenarios. 

Child scenarios allow you to freely change data for one or more elements in your 
system. Child scenarios can reflect some or all of the values contained in their 

parent. This is a very powerful concept, giving you the ability to make changes in 
a parent scenario that will trickle down through child scenarios, while also giving 

you the ability to override values for some or all of the elements in child scenarios. 
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When creating new scenarios, the inherent capabilities can be utilized within Parent-Child scenario relationships 

to define whether the new scenarios are independent or share data and to help manage variations in global 

properties. Refer to Bentley Learn Resources, “Managing Multiple Scenarios” for further training.  

In the FDOTCONNECT Workspace, there are two base scenarios copied into the DGN file from the Hydraulic 

Seed File: Design and Analysis. Both base scenarios use the ‘Base’ Alternatives but differ in Calculation Options. 

• An Analysis performs calculations but does NOT change structure properties 

• A Design option performs calculations and MAY change structure properties. 

 

Note When working in a DGN with multiple scenarios, it is important to know which Scenario is current. This is 
designated by a red check and dictates what information is active / displayed in the model and available in 
tables and calculation results.  

   

By default, the Properties of Design (shown left) and Analysis (shown right) Scenarios have the same ‘Base’ 

settings except for Solver Calculation Options.  
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ALTERNATIVES 

As shown in the Design and Analysis scenario properties above, Scenarios do not contain any specific data, but 

rather reference the various Alternatives. 

As defined in Bentley Drainage and Utilities CONNECT Edition Help, 

Alternatives are the building blocks behind scenarios. They are categorized data sets that create scenarios 

when placed together. Alternatives hold the input data in the form of records. A record holds the data for a 

particular element in your system. 

Similar to Scenarios, Drainage and Utilities models start with Base Alternatives but allow for creation of child 

alternatives. Alternatives can be edited and created through the Alternatives Manager tool, accessible from the 

path: DRAINAGE AND UTILITIES > ANALYSIS > Calculation > Alternatives. 

 

 

Not all types of Alternatives will be used on typical FDOT drainage design projects. Listed below are several 

types that may be useful for typical FDOT projects.  

ACTIVE TOPOLOGY ALTERNATIVE 

As defined in Bentley Drainage and Utilities CONNECT Edition Help: 

The Active Topology Alternative lets you temporarily remove areas of the network from the current 

analysis.  

The Active Topology dialog box is divided into tabs for each element type. 

For each tab, the same setup applies—the tables are divided into three columns. The first column 

displays whether the data is Base or Inherited, the second column is the element Label, and the third 
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column allows you to choose whether or not the corresponding element is Active in the current 

alternative.  

To make an element Inactive in the current alternative, clear the check box in the Is Active. field 

that corresponds to that element’s Label. 

The Alternative Editor Dialog Boxes, including the Active Topology Alternative Editor, can be accessed 

through the Alternatives Tool and right-click: open or double-clicking the specific alternative. 

 

The Alternative Editor dialog boxes are typically organized with tabs for different Drainage and Utility 

features: 

 

USER DATA EXTENSIONS ALTERNATIVE 

In the FDOTCONNECT Workspace, there are several User Data Extensions that have been defined for 

various drainage feature types (Conduit, Catch Basin, Manhole, Outfall, and Headwall). These do not affect 

hydraulic calculations but are provided to help expedite plans production and drainage documentation. Many 

are pick lists which can be selected for proposed drainage features within this dialog box, other flex tables, 

or in Utility Properties. User Data Extensions will be discussed later in this manual. 

PHYSICAL ALTERNATIVE 

A Physical Alternative stores the various physical properties used for hydraulic calculations that are assigned 

to drainage features, primarily sizes and elevations. The Physical Alternative Editor can be a useful interface 

to make individual or global edits to the drainage features in the model. 

Multiple Physical Alternatives allow for comparison between different variations in design (e.g. pipe sizes, 

inverts, etc.) without losing older versions that may still be useful during the design process. New Base or 

Child Physical Alternatives can be created within the Alternative Dialog. Also, Physical Alternatives may be 

created automatically through prompts when computing a “Design” Scenario.  
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Note PLACEHOLDER: are there FDOT deliverable requirements, or any cautionary notes needed when 
drainage models include multiple versions?  

BOUNDARY CONDITION ALTERNATIVES 

The boundary condition alternative allows users to define boundary condition settings for outfall elements. 

Generally, ‘Crown’ or ‘User Defined Tailwater’ settings are best suited to meet FDOT Drainage Manual 

requirements.  

Multiple boundary condition alternatives are useful when tailwater elevations change for different storm 

events.  

 

      

OUTPUT ALTERNATIVES 

The output alternative allows users to define output options for network elements, including conduits and 

channels. 

 

As described in Bentley Drainage and Utilities CONNECT Edition Help: 

When Summary Results is selected, the result attributes are displayed for the start, end, and middle 

of the conduit. Drainage and Utilities breaks a conduit up into a number of longitudinal sections. 
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When Detailed Results is selected, the result attributes are displayed for each of the longitudinal 

sections of the conduit. Only Summary Results are displayed in the graphs and reports for conduits.  

In FDOTCONNECT Workspace, Summary Results is the default option selected in the Base Output.  

RAINFALL RUNOFF ALTERNATIVES 

The rainfall runoff alternative allows users to define runoff data for global rainfall or specific drainage 

elements such as outfalls, catchments and ponds for multiple storm events. By default, there is a single 

alternative, Base Rainfall Runoff. Users can set this event within the Rainfall Runoff Alternative Editor or 

the Global Storm Events dialog.  

New rainfall runoff alternatives can be added for use in other scenarios, such as the absolute 4 in/hr intensity 

for spread analysis at curb inlets. 
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HEADLOSS ALTERNATIVE 

The headloss alternative editor allows users to define headloss properties for manhole, catch basins and 

conduit elements.  

In the FDOTCONNECT Workspace, the Base Headloss alternative default methodology for Minor Losses 

is the Standard Loss Method. This is consistent with FDOT Drainage Design Guide 6.5.7 and FDOT drainage 

structure feature definitions are set up for user-defined loss coefficients.  

As defined in Bentley Drainage and Utilities CONNECT Edition Help, 

Standard loss method - a user-defined loss coefficient is used to calculate the head loss based on 

the velocity head of the exit conduit. The standard method calculates structure headloss based on 

the exit pipe's velocity. The exit velocity head is multiplied by a user-entered coefficient to determine 

the loss. 
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There are several other head loss methods available, depending on the selected solver. Refer to Bentley 

Drainage and Utilities CONNECT Edition Help for further information. 

 

DESIGN ALTERNATIVE 

As defined in Bentley Drainage and Utilities CONNECT Edition Help, 

The Design Alternative Editor allows you to edit the pipe, node and inlet constraints governing the 

design of the system. It also allows you to specify which gravity elements you want designed, and 

the extent to which you want them designed. 

The tabbed dialog for each particular type of element follows the same general format. The top of 

the dialog box contains several fields where the design constraints can be entered. The constraints 

entered in these fields are applied to every element in the table on the bottom of the dialog, except 

the elements that are specified to contain local values. This system allows you to rapidly enter the 

values that govern most of the elements in the table, and then manually override the constraints for 

those elements that are exceptions to the majority. 

By default, the Base Design Alternative applies the global Design Constraints to all drainage gravity pipe, 

nodes and inlets.  

CALCULATION OPTIONS 

Calculation Options can be edited and created through the Calculation Options Manager, accessible from the 

path: DRAINAGE AND UTILITIES > ANALYSIS > Calculation > Options: 
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As defined in Bentley Drainage and Utilities CONNECT Edition Help, 

Calculation options contain attributes that define how your model is calculated in the software. You 

create calculation options in the Calculation Options Manager. You can create several calculation 

options with different attributes depending on the requirements of your model.  

The software contains a default calculation option called Base Calculation Options. If you do not 

create additional calculation options, the software will use this default option whenever you 

calculate your model. 

In the FDOTCONNECT Workspace, several defaults defined in the Design and Analysis options have been 

updated from the default Bentley selections to better align with FDOT standard practices. Additional details 

are provided in Technical Resources. However, users are responsible to ensure calculations meet design 

intent and FDOT Drainage Manual criteria.  

Note In FDOTCONNECT Workspace, the only difference between the default ‘Design’ and ‘Analysis’ options is 
the Calculation Type selection (Design or Analysis): an Analysis performs calculations but does NOT 
change structure properties; a Design option performs calculations and MAY change structure properties. 
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 See the bottom of Properties dialogs for detailed description of the selected field. 
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CALCULATION AND ANALYSIS 

Once default design constraints, scenarios, alternatives and calculation options are set, the model is ready to begin 

calculating. Computing the model can be initiated directly from the ribbon, from Scenario Manager, and from 

the Compute Center. 

Before computing, there is an optional tool available, Validate, for users to identify any input errors. If ‘Compute’ 

is run before validation, the same user notifications will appear. 

VALIDATE 

As defined in Bentley Drainage and Utilities CONNECT Edition Help, the Validate tool 

“Runs a diagnostic check on the network data to alert you to possible problems that may be encountered 

during calculation. This is the manual validation command, and it checks for input data errors.”  

 

 

Results of the validation are reported in the User Notifications Manager. 

NOTIFICATIONS 

User Notifications are messages about the model and can be accessed from the path: DRAINAGE AND 

UTILITIES > ANALYSIS > Calculation > Notifications: 

 

As defined in Bentley Drainage and Utilities CONNECT Edition Help,  

The User Notifications Manager displays warnings and error messages that are turned up by Drainage and 

Utilities V8i validation routines. If the notification references a particular element, you can zoom straight 

to that element by either double-clicking the notification, or right-clicking it and selecting the Zoom To 

command.  

Warnings are denoted by an orange icon and do not prevent the model from calculating successfully.  

Errors are denoted by a red icon, and the model will not successfully calculate if errors are found.  



Chapter 3 DESIGN AND ANALYSIS ________________________________________________________Calculation and Analysis 

FDOTCONNECT for ORD Workflows ©2020 FDOT  3-60 

 

 Corresponding warning icons are shown in plan view. The subject drainage element label, Message ID, 
and Message will display when the mouse hovers over these icons. 

COMPUTE CENTER 

The Compute Center is accessed from the path: DRAINAGE AND UTILITIES > ANALYSIS > Analysis Tools 

> Compute Center:  

 

As defined in Bentley Drainage and Utilities CONNECT Edition Help, 

The compute center is a dialog box that enables the user to quickly and easily keep track of and modify high 

level settings for the current scenario. At a glance, the user can determine what the current scenario is, what 

the active solver is and what set of calculation options are being used. The user can also change these without 

getting into the detailed scenario selection and calculation options dialogs.  

 

 The Compute Center contains icons to activate most of the tools located in the Analysis Tab and 
Calculation Group.  
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CALCULATION SUMMARY 

The Calculation Summary window can be accessed from the path: DRAINAGE AND UTILITIES > 

ANALYSIS > Calculation > Calculation Summary:  

 

As long as the ‘Show this dialog after Compute’ checkbox is checked, the following Calculation Summary 

window will open after Compute Scenario has been initiated and completed. A successful compute will include 

the line “Convergence was achieved” in the Calculation Executive Summary. ‘Details…’ opens the Calculation 

Detailed Summary, with more information organized into tabs for each drainage element type.  

 



Chapter 3 DESIGN AND ANALYSIS ________________________________________________________Calculation and Analysis 

FDOTCONNECT for ORD Workflows ©2020 FDOT  3-62 

 

FLEX TABLES 

In addition to the Calculation Summary tables, Flex Tables are used to access information for specific types of 

elements in the drainage model database. The tabular format allows for easy viewing, sorting, editing, and 

exporting of model input and calculation results. 

The Flex Table Manager can be accessed from the path: DRAINAGE AND UTILITIES > ANALYSIS > 

Analysis Views > Flex Tables:  

 

The Flex Table Manager contains two tabs: Subsurface Utilities and Hydraulic Analysis. Each tab includes a 

section for tables defined in the Hydraulic Model (this DGN), shared (available to multiple DGNs), and 

predefined (from Bentley).    

 

In the FDOTCONNECT Workspace, FDOT Flex Tables have been added to the Hydraulic Analysis tab, in the 

Hydraulic Model section. The FDOT tables are formatted for both plans production and design documentation 

purposes to follow the FDOT Design Manual and Drainage Manual. Flex Tables for plans production and 

drainage documentation workflows will be discussed later in this manual.  

Note Any flex table can be edited to best fit the project. Designers should use the Drainage Manual and Drainage 
Design Guide to determine the information needed to represent the drainage system. 
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 Icons in the Flex Table Manager indicate whether the particular type of drainage element is present in the 
model. In the graphic above, the Ø icon next to the ‘MH’ tables indicates this model does not include manholes. 

The table icon is adjacent to elements that are present, such as catch basins (CB) and outfalls.  

PROFILES 

There are several ways to visualize the computation results and evaluate the network performance including 

three profile visualization tools that can be accessed from the path: DRAINAGE AND 

UTILITIES>HOME>PRIMARY> Explorer> Drainage and Utilities Model > (dgn file) > Profile Runs and 

right clicking on any profile run. Refer to Chapter 2 of this course guide for creating Profile Runs. 

OPEN PROFILE MODEL 

In FDOTCONNECT Workspace, Open Profile Model is a key tool for Plans Production, discussed later in 

this manual. It is used to generate a View that presents the profile run and enables the Vertical Geometry 

tools to interact with the features. 

OPEN ANALYSIS PROFILE 

This analytic profile displays the profile run with HGL and EGL results. There are multiple options to 

customize the display.  
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Note Although this Analysis and Engineering profiles can be exported to drawing, it is a snapshot only and would 
not be automatically updated if the design changes. 

OPEN ENGINEERING PROFILE 

Similar to the Analysis Profile, Engineering Profile displays the HGL results, but includes additional 

customizable label options for the drainage features.   
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EXERCISES 

EXERCISE OVERVIEW – DESIGN & ANALYSIS 

In this exercise, users will select calculation settings, compute a scenario, and analyze results in a variety of 

methods. The network created in Chapter 2 exercises (S-101, S-102, and S-103) will be the starting point for this 

chapter exercise.  

3.1 Review and Set Default Design Constraints 

3.2 Create a new Engineering Standard 

3.3 Create a new Analysis Scenario with adjusted Alternatives 

3.4 Explore Compute Center, Validate the model, resolve Notifications, and Compute Scenario 

3.5 Review Results in Flex Tables 

3.6 Review Results in Analytic Profiles 

Exercise 3.1 Review and Set Default Design Constraints 

 Open FDOTConnect, set the Workspace to “FDOT” and select the Workset – “22049555201_CE”. 

 Browse to the drainage folder and open “DRPRRD01.dgn”. 

 Navigate through the following path and open: DRAINAGE AND UTILITIES>ANALYSIS>Analysis 

Tools> Default Design Constraints:  

 

 Review the available input variables that the software will consider if automated design is performed 

for: 

a. Gravity Pipe: Velocity, Cover, Slope, Tractive Stress, Part Full Design, Number of Barrels, and 

Section Size: 

 

b. Node: 

 

c. Inlet: Maximum Spread and Maximum Gutter Depth are project-specific and require user input 

to compute analysis or design.  
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 Minimum Efficiency on Grade is used when inlet lengths are adjusted to meet a specified efficiency and is 
not applicable in FDOTCONNECT Workspace, where all inlet lengths have fixed dimensions based on Standard 
Plans.  

i. For this example, SR 61 has a 45 mph design speed with an 11 ft outside travel lane, 7 ft 

bike lane and Type F Curb and Gutter. Enter Maximum Spread = 14 ft.   Conservatively 

ignoring the gutter depression, at 0.02 cross slope, enter the corresponding Maximum 

Gutter Depth =  0.28 ft.  

 

Note Exercise 3.1 set the global Default Design Constraints. However, if a project or network has varying 
conditions, use Design Alternatives to assign design constraints to individual and/or groups of drainage 
structures as needed. 
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Exercise 3.2 Create a new Engineering Standard 

In this exercise, users will create an Engineering Standard to check that Pipe Size and Length requirements for 

18 inch pipes are met in the drainage model, according to FDOT Drainage Manual, 3.10.1.  

 Navigate through the following path and open: DRAINAGE AND 

UTILITIES>ANALYSIS>Calculation> Engineering Standards.  

 At the top left of the first row, click the checkbox for Enable.  

 

 Proceed from left to right, completing the columns for the 3.10.1 18” pipe criteria as follows: 

a. Label = “3.10.1 18 inch” 

b. Severity (select from list: Information, Warning, or Error) = Error  

c. Element Type (select from list) = Conduit  

d. For ‘Include Elements’, click the ellipse and populate the query with the following statement 

by double clicking from the field and symbol lists. Enter “18” at the end, and check the box for 

Validate on OK. Click OK. 

 

e. Field = Length (Construction) (ft) 

f. Test Criterion = “<=” 

g. Value = 300.00 

 

 Click the Icon for Validate Using Engineering Standards 
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 The validation will process and automatically close the Engineering Standards Window. Navigate to the 

following path to open the results DRAINAGE AND UTILITIES > ANALYSIS > Calculation > 

Notifications.  

 

 Since there are no pipes that violate this criteria, the Engineering Standards tab in User Notifications is 

blank.   

 To see what happens when a ‘Error’ level severity Engineering Standard is violated, reopen the 

Engineering Standards, overwrite the 300.00 with 100.00, and click the icon for Validate using 

Engineering Standards. 

 

 Click OK to close the error message and Reopen User Notifications. Right click on the error and select 

Zoom To. The conduit that violated the length <= 100.00 ft criteria is now selected. 
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 Errors will not allow the model to compute, until the violation is resolved. Users can set Engineering 
Standards severity based on the level of notification. 

 Close User Notifications, reopen Engineering Standards, replace 100 with 300 in the value field, and re-

validate.  
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Exercise 3.3 Create a new Analysis Scenario with adjusted Alternatives 

In this exercise, users will create a new scenario for a 4 inch/hr intensity event that corresponds to the Drainage 

Manual 3.9.1 spread criteria.  

 Navigate through the following path and open: DRAINAGE AND 

UTILITIES>ANALYSIS>Calculation> Scenarios> Scenario Manager.  

 Since we want this scenario to acquire most of the default properties from the base Analysis scenario, 

right click on Analysis, and select New: Child Scenario. 

 

 Name this scenario “4 in/hr Absolute Intensity (Spread Only)” 

 

 Double-click this scenario to open the properties. The “<I>” indicates the various Alternatives and 

Calculation Options that can be acquired. 
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 Click the pull down list for Rainfall Runoff to view the available Rainfall Runoff Alternatives.  

 

 Select <New…>. The Create New Alternative Window appears with a prompt for the new name. By 

default, the field is populated with a combination of the scenario name and alternative sequence. Select 

OK and close the scenario properties. 

 

 Open the Alternatives Manager from the following path: DRAINAGE AND UTILITIES > ANALYSIS 

> Calculation > Alternatives. Find the new Rainfall Runoff Alternative and double click to open 

properties. 
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 For Global Storm Event, use the pull-down menu to select Absolute Intensity 4 in/hr – 0 Year. Close 

properties and Alternatives Manager.  

a. This can also be selected/edited under the Global Storm Events (DRAINAGE AND UTILITIES 

> COMPONENTS > Common > Storm Data > Global Storm Events. 
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Exercise 3.4 Explore Compute Center, Validate model, resolve Notifications, and 

Compute Scenario 

In this exercise, users will review the Compute Center settings and compute the Analysis Scenario, for the Zone 

2 – 3 Year event.   

 Navigate through the following path and open: DRAINAGE AND UTILITIES>ANALYSIS>Analysis 

Tools> Compute Center.  

 

 The Scenario section includes a pull-down menu to select the ‘current scenario’. As this is changed 

between Design and Analysis type scenarios, the Calculation Type will be updated automatically, based 

on the Calculation Option.  

 

 Select Analysis as the current Scenario. 

 Click the icon to Validate the model. Click OK to close the error message.  

 

 Click the  icon to open the User Notifications Manager and review messages: 
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 The yellow icons indicate the severity is ‘warning’ for these notifications and will not prevent the model 

from computing. Generally, these can be addressed at the designer’s discretion. 

a. In this example, we are not going to address the pipe cover warning, since P-101 is a pipe to 

the pond bottom, which will not have 1’ cover at the MES. 

b. To resolve the time of concentration warning, right-click the row and select Zoom To. This 

will automatically select the catchment DR-101. Hover the mouse over the drainage area 

boundary and open Utility Properties from the quick menu. 

 

 

c. Enter 10.00 in the Time of Concentration (min) field and close the properties dialog. 

d. Repeat Steps 4 and 5 to re-validate the model and view user notifications to see that the time of 

concentration warning has been resolved. 

 Click the Compute icon next to the current scenario and select Scenario.  



Chapter 3 DESIGN AND ANALYSIS ___________________________________________________________________ Exercises 

FDOTCONNECT for ORD Workflows ©2020 FDOT  3-76 

 

 Review the Calculation Summary. 

 

a. The default view displays the current scenario and rainfall. The executive summary includes 

“Convergence was achieved” indicating a successful compute. 

b. Open Messages… and review warning and information only notifications about the model. 

 

c. Open Details… and review the Calculation Detailed Summary with tabs for each type of 

drainage feature. 
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 Close the open dialogs and Compute Center. 

  



Chapter 3 DESIGN AND ANALYSIS ___________________________________________________________________ Exercises 

FDOTCONNECT for ORD Workflows ©2020 FDOT  3-78 

Exercise 3.5 Review Results in Flex Tables 

 Navigate through the following path and open: DRAINAGE AND UTILITIES>ANALYSIS>Analysis 

Views> Flex Tables. 

 In the Hydraulic Analysis tab, review the available  Flex Tables in the Hydraulic Model and 

Predefined groups. 

  

 Open ‘FDOT-Conduit-StormTab’, the FDOTCONNECT Workspace equivalent to the Drainage Manual 

Storm Tabulation format: 

 

a. Right click in any column header to see the table formatting and sorting options. 
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b. Click the Edit icon  to view which database properties are used to populate the table. 

 

c. Close Edit dialog and Click the Export icon  to save the table as a .csv file or the Report 

icon to open the printable views. 

 

 Close the open dialogs and Flex Table Manager. 
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Exercise 3.6 Review Results in Analytic Profiles 

 Navigate through the following path and open: DRAINAGE AND 

UTILITIES>ANALYSIS>Calculation> Scenarios> Scenario Manager.  

 

 Click the Chart Settings  icon to see and turn on available annotation options.  
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 Close the open dialogs. 
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4 PLAN DEVELOPMENT 
WORKFLOW FOR DRAINAGE 
STRUCTURES SHEETS 

INTRODUCTION 

The main focus in this chapter will be on Plan Development Workflow for Drainage Structures Sheets, as 

described in FDM 916. 

The FDOTCONNECT Workspace, includes three default sheet sizes for Drainage Sheets: 11x17, 36x48, and 

36x72. Part 3, Chapter 900 series of the FDOT Design Manual (FDM) outlines Florida Department of 

Transportation (FDOT) NexGen Plans. 

This chapter will introduce several important tools and features available in the Drainage and Utilities Workflow 

and FDOTCONNECT Workspace. They are: 

• Named Boundary 

• Place Note and Place Label 

• Model Annotation 

• Tables 

This chapter will also introduce the user to a new workflow terminology using the Ribbon. If you see a direction 

like this: DRAINAGE AND UTILITIES>DRAWING PRODUCTION>NAMED BOUNDARIES>Named 

Boundary, it means we are in the WorkFlow of Drainage and Utilities which has a Tab named Drawing 

Production and has tools that are located in the Named Boundaries Group. Now that we are in the right 

workflow, Tab and Group we may need to click on a tool that has more than one option. 

NAMED BOUNDARY AND SHEET CUTTING 

In OpenRoads Designer CONNECT Edition, Named Boundaries are used to define clipping areas for plan and 

profile. There are several types of boundaries available in the Named Boundary tool; the FDOT Drainage 

Workflow will typically use Civil Plan and Civil Profile. The Place Named Boundary Civil Plan dialog box is 

shown below. 

The typical FDOT Drainage Workflow is to create a Civil Plan named boundary first with the corresponding 

sheet(s). Subsequently, when the Civil Profile named boundaries are created, these are not placed on new sheets, 

but added to the sheet(s) created with the Civil Plan named boundary. 
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The Drawing Seed selected determines which style sheet is created. In FDOTCONNECT Workspace, the 

predefined FDOT sheet seeds populate the list: 

 
 

 

Based on the ‘Path Element’ selected from the prompt, typically the project baseline or centerline, a New Named 

Boundary Group will be created. The clipping area location and dimensions are defined by the Start and Stop 

Locations (by station), Length, and Left and Right Offsets. When Create Drawing is checked, the sheet is created 

automatically. 
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NAMED BOUNDARIES LIST BOX 

The Named Boundaries list box manages named boundaries and groups in or referenced to the design file and 

can be opened from the  icon at the lower right of the Named Boundaries Group.  

  

 

OTHER FILE CHANGES FROM NAMED BOUNDARIES 

Once Named Boundaries and corresponding sheets are created, there are a few changes to the DGN file:  

MODELS & REFERENCES 

Models are created for both the Named Boundary View(s) and Sheet(s). The Sheet Model automatically 

attaches the View Model as a Reference with Live Nesting which can be adjusted (moved or rotated) 

accordingly. 

• Models Before: 

  

• Models After: 

 

Note Like previous versions of MicroStation, References in this workflow use Live Nesting. Display changes, 
such as turning on or off levels, should only be performed in the Default model. 

SAVED VIEWS 

Saved Views are also created for Named Boundaries and can be managed from the  icon at the following 

path:  DRAINAGE AND UTILITIES>VIEW>SAVED VIEWS 
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In some cases, special details may be needed to show design intent. For example, these cases may include non-

standard structures or structures with multiple or off-centered pipe connections. If these features are modeled, the 

Create Saved View tool can be used to add an isometric view from the 3D model to plans.  

 

ANNOTATION AND LABELING 

For Drainage Workflows in the FDOTCONNECT Workspace, predefined dynamic and automated FDOT plans 

labels have been established for use with the Place Label and Model Annotation tools.  

PLACE LABEL 

The Place Label tool is used in the FDOT Drainage Plans Production Workflow to manually add dynamic labels 

for plan view and can be accessed from the path: DRAINAGE AND UTILITIES > DRAWING PRODUCTION > Notes > Place 

Label 

 

As described in Bentley Drainage and Utilities CONNECT Edition Help, 
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A label is a cell that can maintain association to the element that is being labeled. If the cell definition 

contains fields, the fields will be updated based on the element being labeled.  

Place Label Settings has two type options, Cell and Text Favorite. For the FDOTCONNECT Workspace, all 

Drainage and Utilities Text Favorites and Cells are named with the prefix “_SU_” 

 

Note Labels are placed on the active level. Make sure the correct level is active before using the Place Label 
tool. It is recommended that drainage structure numbers use the level TextLabel and drainage pipe 
numbers use the level TextMinor so that other plans that attach the drainage file as a reference can isolate 
which labels are displayed. 

TEXT FAVORITES 

For Drainage Workflows in FDOTCONNECT Workspace, text favorites are used for labeling drainage pipes and 

drainage areas. The Text Favorites Manager is accessed through the  icon at the following path: DRAINAGE 

AND UTILITIES > DRAWING PRODUCTION > Annotations.  

 

 

CELL  

For Drainage Workflows in FDOTCONNECT Workspace, cells are used for labeling drainage structure numbers. 

The cell library is named SUDA_LABELS.cel.  
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MODEL ANNOTATION 

The Model Annotation tools (Annotate Model and Remove Model Annotations) are used in the FDOT Drainage 

Plans Production Workflow for automated dynamic labeling of drainage profiles and can be accessed from the 

path: DRAINAGE AND UTILITIES > DRAWING PRODUCTION > Annotation > Model Annotation. 

 

In the FDOTCONNECT Workspace, Model Annotation is automatically applied to drainage profiles when 

Named Boundary Civil Profile is used. The drainage structure and pipe annotation should update automatically 

if changes are made, such as renaming or relocating. However, Remove / Annotate can be activated to refresh 

the labels without switching models or views. 

The Annotate Model tool uses Annotation Groups included with the FDOTCONNECT Workspace. 

ANNOTATION GROUPS 

Profile grid, pipe and drainage structure labels are included with the Profile Annotation Groups. They can be 

managed from the Project Explorer, OpenRoads Standards tab: 
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TABLES 

In OpenRoads Designer CONNECT Edition, tables are an effective way to organize and report the drainage 

model database information. In the FDOT Drainage NexGen Plans Production Workflow, most drainage structure 

and pipe information is shown in plans through tables. Several FDOT flex tables have been developed to follow 

the Chapter 900 series of the FDOT Design Manual (FDM).  

 

           

 

 

 

Note In OpenRoads, there are separate flex tables for different types of drainage features (catch basin, manhole, 
headwall, and outfall). However, once the flex tables are exported to .csv, similar tables can be merged 
and sorted to complete a single Structure Data table. 

The Place Table tool can be used to place flex tables (exported to .csv / .xls files) in plans and is accessed from 

the path: DRAINAGE AND UTILITIES > DRAWING PRODUCTION > Tables > Place Table. 
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When a placed table is selected, the Table Tools Layout Tab appears with multiple editing and formatting options.  

 

The FDOT flex tables for plans include some custom fields that allow for FDOT-specific data to be included with 

the drainage model database. The custom fields are defined and managed within the User Data Extensions Tool.   

USER DATA EXTENSIONS 

The User Data Extensions tool is accessed from the path: DRAINAGE AND UTILITIES > TOOLS > General 

Tools > User Data Extensions. 

 

 

In the FDOTCONNECT Workspace, the User Data Extensions have been defined for use in the FDOT Flex 

Tables under Hydraulic Analysis Data Type. For most projects, users will not need to make edits to the User 

Data Extension definitions. 
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For the FDOT Drainage Workflow, the user selections for the fields with User Data Extension can be made 

from the pulldown menus within the FDOT Flex Tables.  

 

Note For catch basins (CB) and manholes (MH) the ‘TopBot’ FDOT flex tables are where the top and bottom 
names can be selected. For pipes, headwalls, and outfalls, the User Data Extension selections can be 
made directly in the respective ‘Plans’ Flex Tables. 

EXERCISES 

EXERCISE OVERVIEW – PLAN DEVELOPMENT 

In this chapter exercise, users will create named boundaries, a drainage structure sheet, and add plans information 

through labels and tables. The network created in Chapter 2 and used in Chapter 3 exercises (S-101, S-102, and 

S-103) will be the starting point for this chapter exercise.  

 

4.1 Place Named Boundary Civil Plan  

4.2 Place Named Boundary Civil Profile 

4.3 Place Drainage Labels in Plan 

4.4 Place Tables 
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Exercise 4.1 Place Named Boundary Civil Plan 

 Open FDOTConnect, set the Workspace to “FDOT” and select the Workset – “22049555201_CE”. 

 Browse to the drainage folder and open “DRPRRD01.dgn”. 

 Navigate through the following path and open: DRAINAGE AND UTILITIES>DRAWING 

PRODUCTION>Named Boundaries> Named Boundary > Place Named Boundary. 

    

a. Select the Civil Plan mode. 

b. Set Drawing Seed to 36x48 Drainage Plan. 

c. In the 2D view, following the ‘Identify Path Element’ prompt, select the CL_SR61 alignment along 

which the plan named boundaries will be created. 

d. Fill out the dialog, as shown. 

e. Follow the prompts in the lower left corner. Left click to define the named boundaries. Multiple left 

clicks may be required. 

f. Two or three clicks are required to (1) accept the Start Location, (2) accept the Stop Location, and 

(3) create the Named Boundaries. However, if the Start or Stop Location are selected graphically 

one or more of these clicks has already been completed. Once completed, the Create Drawing dialog 

automatically opens. 

g. There is typically no need to revise settings in the Create Drawing dialog. With Open Model 

checked, the sheet model will open automatically after clicking OK to create the sheets.  

h. Navigate through the new models to see links between sheets and models. 

 

 



Chapter 4 PLAN DEVELOPMENT WORKFLOW FOR DRAINAGE STRUCTURES SHEETS _______________________ Exercises 

FDOTCONNECT for ORD Workflows ©2020 FDOT  4-92 

o Drainage Plan 1 [Sheet] Views: 

 

o Drainage Plan 1 Views: 
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Exercise 4.2 Place Named Boundary Civil Profile 

 Switch to the Multi-Model Views in DRPRRD01.dgn, activate View Control (hold down the right mouse 

button to open the quick menu for display, and select View Control). Select 3 Views Plan/Profile/3D. 

a. Click OK to the prompt below and select the Profile Run line drawn in plan view from S-103 

to S-102.   

 

 

b. Left click anywhere within the Profile Window to load the Profile Run in profile view.  

 Use the  Quick Profile from Surface Tool to add existing and proposed ground lines from the terrains.  

a. When the Locate Reference Surface prompt activates, a terrain can be selected from the 3D 

view. Once selected, the surface will be displayed in the Profile Window. 
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 Navigate through the following path and open: DRAINAGE AND UTILITIES>DRAWING 

PRODUCTION>Named Boundaries> Named Boundary > Place Named Boundary. 

   

a. Select the Civil Profile mode. 

b. Set Drawing Seed to 36x48 Drainage Profile – Middle. 

c. Click anywhere in the Profile view. 

d. Fill out the dialog, as shown. 

e. Follow the prompts in the lower left corner left click to define the named boundaries. Multiple 

left clicks may be required. 

f. Two or three clicks are required to (1) accept the Start Location, (2) accept the Stop Location, 

and (3) create the Named Boundaries. However, if the Start or Stop Location are selected 

graphically one or more of these clicks has already been completed. 

g. In the Create Drawing dialog, change the Sheet Model Sheets selection to Drainage Plan 1 

[Sheet]. With Open Model checked, the sheet model will open automatically after clicking OK 

to create the sheets.  

h. Navigate between models. 
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o Drainage Plan 1 [Sheet] Views: 

 
o Profile 1 Views: 

 



Chapter 4 PLAN DEVELOPMENT WORKFLOW FOR DRAINAGE STRUCTURES SHEETS _______________________ Exercises 

FDOTCONNECT for ORD Workflows ©2020 FDOT  4-96 

 In the Profile 1 View, review the characteristics of the Model Annotation. Though this annotation is 

automated, sometimes it may necessary to Remove Model Annotations and then Annotate Model again. 

This can help reflect updates to the network and/or fix annotations that did not automatically populate 

with the Named Boundary process. These tools are available from the path: DRAINAGE AND 

UTILITIES>DRAWING PRODUCTION>Annotations> Model Annotation.  

   

a. Choose Remove Model Annotations and left click through the prompts. 

    

b. Choose Annotate Model and left click through the prompts. 

   

c. Select one of the labels and move to another position. 

 

d. Select Annotate Model again and observe the following: 

i. Annotations can be adjusted, but if re-annotated, the default locations (from the Annotation 

Group definitions) are used. 

ii. Annotations can be duplicated.  

e. Change active level to TextLabel and activate Place Note. 

i. Enter the following in the Text Editor “EXISTING GROUND DIRECTLY ABOVE 

PIPE”. 
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f. Redo steps a. and b. to restore default annotation and see that the placed note remains.   
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Exercise 4.3 Place Drainage Labels in Plan 

 For curved alignments and chorded named boundaries, it can be a challenge to find the rotation that 

matches the sheet. This is one way to set the rotation of the plan view so that the labels placed will be 

horizontal relative to the sheet.  

a.  Rotate View with 2 Points Method along the Named Boundary to match the sheet 

orientation.  

 

 Set the Level to a TextLabel before placing any notes or Labels. 

 Navigate through the following path and activate Place Label tool: DRAINAGE AND UTILITIES> DRAWING 

PRODUCTION > Notes > Place Label 

a. Fill out the dialog as shown below, select the curb inlet cell, and left click to accept label 

placement. 
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b. Place labels for S-101, S-102, and S-103: 

 

 Navigate through the following path and activate Place Label tool: DRAINAGE AND UTILITIES> DRAWING 

PRODUCTION > Notes > Place Label 

a. Fill out the dialog as shown below, select the line for P-103, and left click to accept label 

placement. 

 

b. Place labels for P-101 and P-103, use rotation tools as needed: 
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Exercise 4.4 Place Tables 

 Switch to the Multi-Model Views in DRPRRD01.dgn and open Flex Tables from the path: DRAINAGE 

AND UTILITIES>ANALYSIS>Analysis Views> Flex Tables. 

 From the Hydraulic Analysis tab, open FDOT-Plans-CB. 

    

 From the upper left of the menu, select Export to File and save as .csv in the \drainage\eng data folder. 

 

 Navigate through the following path to quickly open the workset drainage folder: OPENROADS 

MODELING>FDOT> Resources > Explore Directories > Current Workset.  
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 Open the .csv file in Excel and update formatting with the following: 

a. Select from cells A1 to J6, and add borders (Home: Font: Borders: All Borders). 

b. Select from cells A1 to J6 and change font to FDOT. 

c. Delete ‘<None>’ from Cells E3:F4 and E6:F6.  

d. Adjust units for significant digits and reshape column widths as needed. 

 

e. Save as .xlsx and close. 

 In OpenRoads, switch to the Drainage Plan 1 [Sheet] Views Model and navigate through the path to 

open Place Table – Select From File, DRAINAGE AND UTILITIES> DRAWING 

PRODUCTION>Tables> Place Table. 

 Select the ellipse next to File Name, browse to and select the new .xlsx. 

 

 Review and click OK to accept the default range from A1 to J6.  

 

 Use the cursor to place table in the lower right of the sheet. 

Label
Baseline 

Feature

Baseline 

Station

(ft)

Baseline 

Offset

(ft)

Structure Type
Bottom 

Dimensions
Notes

Reference 

Point 

Elevation

(ft)

Sump 

Elevation 

(Structure 

Invert)

(ft)

 -Pipe- 

Label

S-101 CL_SR61 706+50 40.00 CURB INLET TYPE P-2 4' DIA. 30.85 24.20

(In) P-103

(Out) P-101

S-103 CL_SR61 705+00 40.00 CURB INLET TYPE P-1 4' DIA. 31.40 25.50

(Out) P-103
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 Select the table to activate the Table Tools available for further formatting and editing. 
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5 DRAINAGE QUANTITIES 

INTRODUCTION 

The main focus in this chapter will be on the tools to extract quantity information from the drainage design model 

available in the OpenRoads Designer CONNECT Edition and FDOTCONNECT Workspace including:  

• Item Types 

• Asset Manager 

• Takeoff Manager 

Automated quantity tools are still in development and methodologies are subject to change. Refer to the 

FDOTCONNECT Automated Quantities Workflow Course Guide for additional information.  

The workflows outlined in this chapter will produce a Summary of Drainage table to be included in the Estimated 

Quantities Report for drainage. As described in Part 3, Chapter 902 of the FDOT Design Manual (FDM), 

quantities are reported with project documentation but are not included in the Roadway Plans Set. 

ITEM TYPES 

In the FDOTCONNECT Workspace, Item Types are used to apply Pay Item quantity information to drainage 

elements.  

The Item Types tools can be accessed from the following path: OPENROADS MODELING > HOME > Item 

Types >. 

 

 

The FDOT Drainage Item Types are based on FDOT Pay Item Number groupings in Basis of Estimates and can 

be viewed in the Item Types Manager, by clicking the icon in the lower right corner of the Item Types Group. 

For all drainage structures, the corresponding FDOT Item Type is included with the Feature Definition, and 

therefore automatically attached when structures are placed. For drainage pipe, Item Types are attached after 

placement. In each case, the Drainage Item Types provide the framework in the properties dialog for users to 

select from picklists that generate the appropriate Pay Item Number. 

Note Since Item Types are added to the drainage element properties (not Utility Properties), Pay Item 
information is not accessible to Flex Tables. 
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ASSET MANAGER 

In the FDOTCONNECT Workspace, Asset Manager is used to assign Alignment and FPID information to 

elements for use by FDOT Quantity Takeoff Manager.  

Asset Manager can be accessed from the following path: OPENROADS DRAWING PRODUCTION > HOME 

> Model Analysis and Reporting > Asset Manager. 

 

FDOTPROJECT.XLSM 

For FDOTCONNECT Workflows, the first step in the Asset Manager workflow is to define the project 

alignments and/or FPID as applicable in a pre-formatted spreadsheet named FDOTProject.xlsm. Each project 

will have to complete the spreadsheet and save in the workset (symb/Symbology folder). The spreadsheet 

template may be copied from the folder location: C:\FDOTConnect\Organization-Civil\FDOT\Asset 

Manager\ FDOTProject.xlsm.  
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The _Pick List Definitions tab has the following content:  

• Row 1 is preformatted to automatically update as alignment or FPID content is added. 

• Row 2 is for users to add alignment(s) from left to right, starting at cell B2. 

• Row 3 is for users to add FPID(s) from left to right, starting at cell B3.  

 

ASSET MANAGER TOOL 

When activated, the two icons at the top of the Asset Manager tool are for the following:   

   

Once the FDOTProject.xlsm spreadsheet has been completed for the project and saved to the workset 

directory, Asset Manager can read the alignment and FPID project information and assign to selected 

elements.  
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This tool can also be used to replace or remove alignment and FPID information.  

FDOT QUANTITY TAKEOFF MANAGER 

In the FDOTCONNECT Workspace, the Takeoff Manager is used to create the Estimated Quantities Report. The 

tool extracts quantity information from the drainage elements in or referenced to the model and formats the 

information into an auto-populated, standardized table.  

Note Quantity reports for all disciplines use the same standardized table, with columns hidden or displayed 
accordingly.   

The Takeoff Manager tool can be accessed from the following path: OPENROADS MODELING > FDOT > 

Quantities >. 

 

When prompted, the tool opens with a complete list of available reports. The Summary of Drainage report is used 

for all Drainage Item Types. 
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By default, the spreadsheet report is saved in the project Workset’s calculations subfolder and the PDF report is 

saved in the project Workset’s estimates subfolder. Both locations can be quickly accessed from OpenRoads with 

following tool: OPENROADS MODELING>FDOT> Resources > Explore Directories > Current Workset.  

 

 

 

 

 



Chapter 5 DRAINAGE QUANTITIES ___________________________________________________________________ Exercises 

FDOTCONNECT for ORD Workflows ©2020 FDOT  5-109 

The quantity information reported in the standard table includes several ways to locate the corresponding 

elements in the DGN model. In addition to the drainage Structure Number and Pipe Numbers (reported in Label 

column), the Element ID corresponds to a unique value assigned to the properties of each individual element in 

the DGN.  

 

The Select by Element ID tool can be accessed from the following path: OPENROADS MODELING>FDOT> 

Actions > Misc. Tools > Select Element by ID.  

 

  

EXERCISES 

EXERCISE OVERVIEW – DRAINAGE QUANTITIES 

In this chapter exercise, users will create a Summary of Drainage Report for a sample network. The network 

created in Chapter 2 and used in Chapters 3 & 4 exercises (S-101, S-102, and S-103) will be the starting point 

for this chapter exercise.  

 

5.1 Explore Item Types Manager 

5.2 Generate Pay Item Numbers for sample drainage structures 

5.3 Attach Item Types to sample pipes and generate Pay Item Numbers 

5.4 Create a Selection Set 

5.5 Attach alignment information for quantities 

5.6 Use Takeoff Manager to generate Summary of Drainage table 

5.7 Explore Items in Project Explorer and delete strays  
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Exercise 5.1 Explore Item Types Manager for Drainage 

 Open FDOTCONNECT, set the Workspace to “FDOT” and select the Workset – “22049555201_CE”. 

 Browse to the drainage folder and open “DRPRRD01.dgn”. 

 Navigate through the following path and open Item Types Manager: OPENROADS 

MODELING>HOME>Item Types> . 

 

 

 Hover over Drainage Quantities and verify the following message appears: 

. 

 Close the dialog. 

Note When working with Item Types in a DGN file for the first time after its been opened, sometimes the Item 
Types properties are blank or non-responsive within the element Properties dialog. If that happens, repeat 
this exercise (open Item Types Manager) to reactivate the properties. 
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Exercise 5.2 Generate Pay Item Numbers for sample drainage structures 

 Switch to the Default or Multi-Model Views in DRPRRD01.dgn, activate View Control, and select 1 

View and zoom towards S-101, S-102, and S-103. 

 Select S-103 and open the element properties  (from Primary Group in any tab). Scroll down to the 

DrainageInlet section: 

a. Click in the field next to Type to access the pulldown picklist and select CurbTypeP-1 as 

shown below. 

b. For Depth, select LessOrEq10ft from the picklist. 

c. The PayItemNumber is not editable, but will automatically be completed based on selections in 

a and b. 

d. For DesignNotes, add “Sample notes for S-103” into the text field. 

e. For ConstructionRemarks, leave this field blank. 

  

 

 Repeat steps for S-101 and S-102 with the data shown below. 

  

 Close properties dialogs. 
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Exercise 5.3 Attach Item Types to sample pipes and generate Pay Item Numbers 

 Select P-103, open element properties and review. Note there is not yet a section for Item Types. Close 

the properties dialog but keep P-103 selected. 

 Navigate through the following path and select Attach Item: OPENROADS MODELING>HOME>Item 

Types>Attach Item. 

 For Item Types: select DrainageQuantities:DrainagePipe from the pulldown menu. 

 

 The Item Type property selections can be made in this dialog or later in element properties. Complete 

the dialog or item types properties with the following information: 

a. Type = StormAndCrossDrain 

b. Shape = Round 

c. Size = 18 

d. PayItemNumber is not editable, but will automatically be completed based on selections in a,  

b, and c. 

e. DesignNotes = “Sample notes for P-103”  

 

 Left click to accept the prompt in the lower left, to apply the Attach Item settings.  
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 Reopen element properties to verify DrainagePipe section is complete with the Item Type properties. 

 

 Close the properties dialog and repeat steps 1 through 6 for P-101. 

 

Note Use level display and selection sets to select and set groups with the same Item Types. 
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Exercise 5.4 Create a Selection Set 

Selection sets are useful to quickly select groups of elements for a variety of uses. In the next exercise, the 

selection set allows properties to be set just once and avoids unnecessary repetition.   

 Navigate through the following path and select Selection Sets: DRAINAGE AND 

UTILITIES>UTILITIES VIEW>Selection and Query>Selection Sets. 

 

 Click the New icon and select Create from Query. 

 

 From the list of Available Items, select All Nodes and All Conduits and click Add ‘>’ and click OK to 

close the dialog. 

 

 In the Selection Sets Manager, right click the new ‘Selection Set – 1’ and click Select in Drawing to 

verify the 2 pipes and 3 drainage structures are included. Close the dialog. 
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Exercise 5.5 Attach alignment information for quantities 

This exercise is going to generate a pick list and item type for the project alignments and assign to drainage 

features.  

 Outside of OpenRoads, navigate through File Explorer to the workset symb/Symbology subfolder: 

C:\Worksets\FDOT\22049555201_CE\symb and locate the file FDOTProject.xlsm 

 

Note New projects created through “Create Project” will already have this file copied to the symbology folder. If 
already in workset folder, skip step 2. 

 Navigate through File Explorer to the FDOTConnect Asset Manager resources. Workstation installations 

typically use the path: C:\FDOTConnect\Organization-Civil\FDOT\Asset Manager: 

a. Find and copy the file FDOTProject.xlsm  

b. Paste the file into the workset symb/Symbology subfolder: 

C:\Worksets\FDOT\22049555201_CE\symb 

 Open the spreadsheet and in the _Pick List Definitions tab, fill in the following cells: 

a. Cell B2 = CL_SR61 

b. Cell B3 = US98 

 

c. Save and close FDOTProject.xlsm 

 Back in OpenRoads, navigate through the following path and open Asset Manager: OPENROADS 

DRAWING PRODUCTION>HOME>Model Analysis and Reporting> Asset Manager. 

 

 From Asset Manager, select the  icon to Open Asset Definitions File and select FDOTProject.xlsm. 
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a. Check the box for Alignment. 

  

Note Typically, FPID should not be attached unless the project has multiple funding sources (sequencing). 

b. In the Elements section of the tool, change setting from All Elements to Selection Set. 

c. From the path, DRAINAGE AND UTILITIES>UTILITIES VIEW>Selection and 

Query>Selection Sets,  open Select Sets Manager, and right click Selection Set – 1, and choose 

Select in Drawing. 
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d. In the Asset Manager window, under the Assign Tab, click Add Assets. 

e. Verify successful attachment from messages at the bottom of the OpenRoads window. 

 

f. Close the Asset Manager tool. 

 With the selection set still active, open properties and set the alignment CL_SR61 for all elements. 
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Exercise 5.6 Use Takeoff Manager to generate Summary of Drainage table 

Once Pay Item Numbers are generated and alignments assigned, the Takeoff Manager is ready to run. 

 Open the FDOT Quantities Takeoff Manager from the path: OPENROADS MODELING > FDOT > 

Quantities >. 

 

a. Open the pulldown menu for ‘Report station and offset relative to:’ and verify the relevant 

project alignments are recognized. Keep ‘All’ as the selected option.  

b. Check the boxes for Include References, Output Upper Case, and Open Output File(s). 

c. Click Compute. 
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d. Select OK to the following prompts. 

 

Note Any previous tables with the same file name and location will be replaced when OK is clicked in the prompt 
shown above. Ensure no valuable information will be lost by renaming or relocating files as needed. 

  

 Review the new Excel sheet Summary of Drainage.xlsx and close when complete. 

 

 Back in the FDOT Quantity Takeoff manger Tool, click Create PDF.  

Note Summary of Drainage PDFs may be useful for QC purposes, but must be delivered within the complete 
Estimated Quantity Report generated by the Prime/EOR.  

 In the following prompt, check the box for Summary of Drainage, select Convert and OK to the following 

prompts: 
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 Navigate through the following path to open the estimates subfolder and the Summary of Drainage pdf: 

OPENROADS MODELING>FDOT> Resources > Explore Directories > Current Workset.  
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Exercise 5.7 Explore Items in Project Explorer and delete strays 

FDOT methodologies are subject to change as further Bentley refinements are implemented with OpenRoads 

updates.  

One of the identified limitations in the OpenRoads CONNECT Edition –Version 10.08.01.33 is the duplication 

of items associated with drainage structure cells. A stray item is added to the drainage structure shapes 

associated with the connection regions. This example shows how to detect and delete these duplicate drainage 

structure items. Drainage pipes are not affected by this issue.  

Note Warning: the process described in this exercise may significantly slow performance and require restart if 
using Version 10.08.  

 If not already docked and open, click F11 to Toggle Project Explorer, or use following path and navigate 

to Items: DRAINAGE AND UTILITIES>HOME>PRIMARY>Explorer>Items. Expand the sections for 

DrainageInlet and Drainage MES: 

 

a. Note the intended total of drainage structures is Drainage Inlets (2: S-101 and S-103) and MES 

(1: S-102), but the total in the Items sections is double. 

b. Scroll through the list and the corresponding selected element in the DGN will be highlighted. 

c. Find the items corresponding to the Drainage Inlets where the whole structure is highlighted. 

 

d. Find and select the items that do not highlight the entire structure, but just the connection 

regions. These will be deleted in the next steps. 
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 Typically, these stray lines are placed on the level Default. Use the level filter in the Element Selection 

tool to select all the elements on Default. It is OK if more than just the stray items are selected in this 

process.   

 

 Keeping the selection from Step 3, open Detach Item from the path: OPENROADS 

MODELING>HOME>Item Types> Detach Item. 

 

 The options of Items attached to the selection are listed. Check boxes for DrainageInlet and 

DrainageMES.  

 

a. Left click to accept the prompt in the lower left to attach:  

 

b. The message at lower left confirms successful attach:  

c. Also, to confirm, the Item Tab in Project Explorer now correctly shows 3 item types attached 

to drainage structures: 
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6 DRAINAGE DOCUMENTATION  

INTRODUCTION 

The focus in this chapter will be on the tools available in OpenRoads Designer CONNECT Edition to fulfill 

FDOT Drainage Manual 3.13.1 drainage documentation requirements. For additional guidance on storm drain 

calculations and documentation, see FDOT Drainage Design Guide Chapter 6. The Drainage Workflows for 

FDOTCONNECT aim to provide the required information but are presented in a new format.    

In OpenRoads Designer CONNECT Edition, reports and tables are an effective way to organize and convey the 

drainage model database information and calculations. The FDOT Drainage Workflows for OpenRoads Designer 

accomplish drainage documentation primarily through a combination of reports and flex tables available in the 

FDOTCONNECT Workspace. 

As discussed in FDM 916, large format sheets can accommodate a combination of multiple model views and 

tables. For drainage documentation of storm drain networks, the workflows described in this chapter also pair 

relevant tables with depictions of the storm drain network. For purposes of this course guide, this will be referred 

to as the FDOT storm drain documentation sheet. The general steps of adding tables to sheets shown in Chapter 

4 also apply here: 1) export table to Excel, and 2) place table in sheets.  

The drainage documentation tools and features discussed in this chapter are: 

• Place Label 

• Hydraulic Model Properties 

• Reports 

o Hydraulic Model Inventory 

o Calculation Summary 

• Tables 

o OpenRoads Tables 

o FDOT Flex Tables 

• Place Table 

 

PLACE LABEL 

For FDM 903 Drainage Map and/or the FDOT storm drain documentation sheet, the Place Label tool with text 

favorites can be used to add drainage area information to plan view. For additional guidance on the Place Label 

tool, see Chapter 4 of this course guide.  

The Place Label tool is used in the FDOT Drainage Plans Production Workflow to manually add dynamic labels 

for plan view and can be accessed from the path: DRAINAGE AND UTILITIES > DRAWING PRODUCTION 

> Notes > Place Label. 

 

Note Labels are placed on the active level. Make sure the correct level is active before using the Place Label 
tool. It is recommended that drainage area labels use the level TextDetails so that other plans that attach 
the drainage file as a reference can isolate which labels are displayed. 
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The Favorite Name: ‘_SU_PLAN_NODE_ID’ also works to add the label for the catchment (drainage area) ID.  

 

 

HYDRAULIC MODEL PROPERTIES 

In the OpenRoads Designer CONNECT Edition, Hydraulic Model Properties is a tool available to document 

designer information and model notes. This information can be included in a report, exported to Excel, and placed 

in the FDOT storm drain documentation sheet.  

The Hydraulic Model Properties dialog can be accessed from the following path: DRAINAGE AND UTILITIES 

> TOOLS > Project Tools > Project > Project Properties. 

 

 

REPORTS 

In OpenRoads Designer CONNECT Edition, a variety of predefined Reports are included with the installation. 

Additionally, Custom Report is a tool to build a report based on a variety of model input and results. Reports can 

be exported to several different formats, including Excel. In the FDOT Drainage Documentation Workflow, some 

of the required drainage documentation can be accessed from Reports.  

Reports can be accessed from the following path: DRAINAGE AND UTILITIES > REPORT > Drainage and 

Utilities.  
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Some of the predefined Drainage and Utilities reports open a Flex Table and others open a Report ‘Preview’. The 

Report ‘Preview’ types cannot be formatted with OpenRoads tools. However, both types may be exported for 

further formatting as needed. 

HYDRAULIC MODEL INVENTORY: 

An example of a predefined Report ‘Preview’ that can be useful for FDOT drainage documentation is the 

Hydraulic Model Inventory. The contents include Hydraulic Model Properties, an abbreviated Scenario 

Summary, and the Network Inventory. The Scenario Summary section shows the type of computation and 

Alternatives selected. 

 

CALCULATION SUMMARY: 

This report includes a summary of the calculations performed on the model and warning messages. When 

activated from the menu, or following a computation, the GVF-Rational Calculation Summary Window 

opens. The ‘Report’ button at the bottom will generate a Calculation Executive Summary.    
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If the ‘Details…’ button is selected, a second window, ‘Calculation Detailed Summary’ will open with tabs 

for various drainage feature types. The ‘Report’ button generates a Calculation Detailed Summary Report.  
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TABLES 

Tables are needed to supplement the documentation provided by the OpenRoads predefined reports. Since any 

table in OpenRoads can be exported or copy/pasted to Excel for documentation purposes, there is a wide variety 

of tables and information to choose from. Typical applications of both OpenRoads Tables and FDOT Flex Tables 

are discussed in the following sections.  

OPENROADS TABLES: 

Although some of the predefined OpenRoads summary reports include a list of which Alternatives were 

selected for use in the computation settings, designers may choose to document further details as needed.   

For example, if minor losses are calculated, the Headloss Alternative table may be exported for a concise 

summary of methodology and loss coefficients selections. 
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or: 

 

Another example of additional supporting details is the Rainfall Runoff Alternative. If the Report  icon is 

selected, a report Preview will generate that includes the maximum (10 minute) storm intensity based on 

FDOT IDF curves. 

 

* ID Label

Headloss 

Method

HEC-22 

Benching 

Method

Absolute 

Headloss 

(ft)

Headloss 

Coefficient 

(Downstream)

Headloss 

Coefficient 

(Upstream)

Headloss 

Coefficient 

(Standard)

AASHTO 

Shaping 

Method

Flow-

Headloss 

Curve

BASE HEADLOSS: CATCH BASIN HEADLOSS
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A different way of summarizing rainfall, if multiple events are used in computations, is from the Global Rain 

Events table (DRAINAGE AND UTILITIES > COMPONENTS > Common > Global Storm Events 

 

 

FDOT FLEX TABLES: 

Where feasible, FDOT Flex Tables have been developed to resemble familiar documentation formats shown 

in the FDOT Drainage Manual and FDOT Drainage Design Guide. These tables can be accessed from the  

Flex Table Manager at the path: DRAINAGE AND UTILITIES > ANALYSIS > Analysis Views > Flex 

Tables.  

 

The FDOT drainage documentation flex tables are located in the Hydraulic Analysis Tab: 

Alternative Global Storm Event Source

Return 

Event 

(years)

Depth 

(in)

Duration 

(Modified 

Rational) 

(min)

Maximum 

Storm 

Intensity 

(in/h)

Intensity 

(Average) 

(in/h)

Climate 

Adjustment 

Type

Climate 

Adjustment 

(%)

Base Rainfall Runoff Zone 2 - 3 Year Orphan (local) 3 0 0 7.596 0 None 0

4 in/hr Absolute Intensity (Spread Only)Absolute Intensity 4 in/hr - 0 Year Orphan (local) 0 0 0 4.000 0 None 0

GLOBAL STORM EVENTS
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FDOT-SPREAD: 

The FDOT-Spread flex table is comparable to FDOT Drainage Design Guide Table 6.3-1 and documents to 

spread and inlet capacity analysis.  

 

 
FDOT-OUTFALL: 

The FDOT-Outfall flex table is a supplement to the FDOT-Conduit-StormTab table that documents the 

tailwater conditions used in the hydraulic calculations.  

 

FDOT-CONDUIT-STORMTAB: 

The FDOT-Conduit-StormTab flex table is comparable to FDOT Drainage Manual Figure 3-2: Storm Drain 

Tabulation Form and documents the results of hydrologic and hydraulic calculations for storm drain systems.  

 

 

FDOT-CATCHMENT: 

The FDOT-Catchment flex table is comparable to FDOT Drainage Areas Tabulation form, a previous FDOT 

GEOPAK Drainage report. This table is useful when multiple subareas define a composite C value. 

 

Label
Baseline 

Feature

Baseline 

Station

(ft)

Baseline 

Offset

(ft)

Inlet

Inlet 

Drainage 

Area

(acres)

Inlet C

Total Inlet 

Intensity

(in/h)

Total Rational 

Flow to Inlet

(cfs)

Road 

Cross 

Slope

(%)

Gutter 

Cross 

Slope

(%)

Longitudinal 

Slope 

(Inlet)

(%)

Manning's 

n (Inlet)

Depth 

(Gutter)

(in)

Spread / 

Top Width

(ft)

Maximum 

Spread

(ft)

Inlet 

Location

Capture 

Efficiency 

(Calculated)

(%)

Intercepted 

Rational 

Flow

(cfs)

Bypassed 

Rational 

Flow

(cfs)

Bypassed 

Additional 

Carryover 

Flow

(cfs)

Bypass 

Target

SPREAD CALCULATIONS

Label
Baseline 

Feature

Baseline 

Station

(ft)

Baseline 

Offset

(ft)

Inlet

Inlet 

Drainage 

Area

(acres)

Inlet C

Total Inlet 

Intensity

(in/h)

Total Rational 

Flow to Inlet

(cfs)

Road 

Cross 

Slope

(%)

Gutter 

Cross 

Slope

(%)

Longitudinal 

Slope 

(Inlet)

(%)

Manning's 

n (Inlet)

Depth 

(Gutter)

(in)

Spread / 

Top Width

(ft)

Maximum 

Spread

(ft)

Inlet 

Location

Capture 

Efficiency 

(Calculated)

(%)

Intercepted 

Rational 

Flow

(cfs)

Bypassed 

Rational 

Flow

(cfs)

Bypassed 

Additional 

Carryover 

Flow

(cfs)

Bypass 

Target

SPREAD CALCULATIONS

Label

Baseline 

Feature

Baseline 

Station

(ft)

Baseline 

Offset

(ft)

Elevation 

(Ground)

(ft)

Elevation 

(Invert)

(ft)

Boundary 

Condition 

Type

Boundary 

Element

Elevation (User 

Defined 

Tailwater)

(ft)

System 

CA

(acres)

System 

Flow Time

(min)

System 

Intensity

(in/h)

System 

Rational 

Flow

(cfs) Notes

OUTFALL CONDITIONS

Label

 -Node- 

Upstream 

Downstream

Length 

(Unified)

(ft)

Upstream 

Inlet 

Area

(acres)

System 

Drainage 

Area

(acres)

System 

CA

(acres)

System 

Flow 

Time

(min)

Time 

(Pipe 

Flow)

(min)

System 

Intensity

(in/h)

System 

Additional 

Flow

(cfs)

System 

Rational 

Flow

(cfs)

Upstream 

Structure 

Headloss

(ft)

Elevation 

Ground 

(Start)

(ft)

HGL 
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The individual subareas flex tables can also be accessed and exported to Excel through the ellipses shown in 

the ‘Subareas’ column of the FDOT-Catchment flex table. 

 

 

 

PLACE TABLES 

Once the appropriate reports and tables have been exported to Excel, the Place Table tool can be used to add 

these to the FDOT storm drain documentation sheet(s). This tool is accessed from the path: DRAINAGE 

AND UTILITIES > DRAWING PRODUCTION > Tables > Place Table. 

 

 

When a placed table is selected, the Table Tools Layout Tab appears with multiple editing and formatting 

options.  
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EXERCISES 

EXERCISE OVERVIEW – DRAINAGE DOCUMENTATION 

In this chapter’s exercises, users will locate & export various OpenRoads reports and tables to Excel. A new 

FDOT storm drain documentation sheet will be created and populated with the exported tables. The scenarios 

and network set up in Chapter 2 and used in Chapters 3-5 exercises (S-101, S-102, and S-103) will be the starting 

point for this chapter exercise.  

6.1 Complete the Hydraulic Model Properties 

6.2 Compute Center: Review Properties and Run Analysis Scenario (Zone 2 – 3 Year) 

6.3 Export a Hydraulic Model Inventory Report to Excel 

6.4 Copy/Paste Global Storm Events data to Excel 

6.5 Export FDOT Flex Tables to Excel 

6.6 Compute Center: Run 4 in/hr Absolute Intensity (Spread Only) Scenario 

6.7 Export FDOT-Spread Flex Table to Excel 

6.8 Create FDOT storm drain documentation sheet and place labels 

6.9 Place Tables, from Excel, in FDOT Storm Drain Documentation Sheet  
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Exercise 6.1 Complete the Hydraulic Model Properties 

 Open FDOTCONNECT, set the Workspace to “FDOT” and select the Workset – “22049555201_CE”. 

 Browse to the drainage folder and open “DRPRRD01.dgn” and use Manage View Groups (see lower 

left of OpenRoads window) to set Active View Groups to Default or Multi-Model Views. 

 

 Navigate through the following path and select the Project Properties icon: DRAINAGE AND 

UTILITIES > TOOLS > Project Tools > Project > Project Properties. 

 

 In the Hydraulic Model Properties window, complete the text fields with the following information: 

a. Title: FDOTCONNECT Example Exercise 

b. Engineer: First Last, P.E. 

c. Company: Company, Inc. 

d. Date: 1/1/2021 

e. Notes: 

This model represents an example system developed for purposes of 

navigating through OpenRoads Drainage and Utilities tools. 

Checked by: ## 

Checked date: ## 
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 Select OK to accept the updates and close the Hydraulic Model Properties window.  
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Exercise 6.2 Compute Center: Review Properties and Run Analysis Scenario (Zone 2 – 

3 Year) 

This exercise revisits the Compute Center, ways to review the scenario before computation, and rainfall 

properties to be included in drainage documentation.  

 Navigate through the following path and open the Compute Center: DRAINAGE AND UTILITIES > 

ANALYSIS > Analysis Tools > Compute Center. 

 

 The active scenario, shown in the pull-down menu, is Analysis. 

a. To review the Alternatives selections for the Analysis scenario, select the  Scenarios icon.  

 

b. From the Scenarios Manager window, double-click Analysis to open Properties.  

 

c. In Properties, note the Rainfall Runoff Alternative is set to Base Rainfall Runoff.  
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d. To view or edit details of Base Rainfall Runoff, select the Alternatives icon from Compute 

Center. The following Alternatives window opens:  
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e. Double-click Base Rainfall Runoff in the Alternatives window to open the editor shown below. 

Note, the Global Storm Event selected is Zone 2 – 3 Year. 

 

f. Close the editor, Alternatives, and Scenario Properties windows. From Compute Center, select 

the icon to Compute Scenario. After computation is complete, close all open dialogs. 
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Exercise 6.3 Export a Hydraulic Model Inventory Report to Excel 

 Navigate through the following path and open the Hydraulic Model Inventory report: DRAINAGE AND 

UTILITIES > REPORT > Drainage and Utilities > Hydraulic Model Inventory. 

 

a. The following window will appear while the report is being generated. 

 

b. The Hydraulic Model Inventory information entered in Exercise 6.1 is automatically included 

in the report preview. 

 

 From the Preview menus, select File: Export Document: Excel File.  

 

a. Select OK to the following prompt: 
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b. Save the .xls in the example workset folder, drainage: eng_data subfolder.  

 

c. Select Yes in the following prompt to open the file:  

 

 In Excel, review the report contents. In addition to Hydraulic Model Inventory information, a Scenario 

Summary, Network Inventory, and Circle Inventory populate the report.  

 For the purposes of this example, the only information to be placed into the sample storm drain 

documentation sheet are the Hydraulic Model Inventory and Scenario Summary. 

a. Use the tools in Excel to delete rows as shown below: 
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b. Save and close the Excel file. 
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Exercise 6.4 Copy/Paste Global Storm Events data to Excel 

This exercise revisits the Global Storm Events, which can be used for drainage documentation. This table shows 

all events selected for use by Rainfall Runoff Alternative(s). The model in this exercise contains two rainfall 

events: 

• The Zone 2 – 3 Year event is selected for the Base Rainfall Runoff Alternative in the Analysis 

Scenario. 

• The 4 in/hr Absolute Intensity – 0 Year event is selected for the 4in/hr Absolute Intensity (Spread 

Only) Rainfall Runoff Alternative in the 4 in/hr Absolute Intensity (Spread Only) Scenario.  

 In OpenRoads, navigate through the following path and open Global Storm Events: DRAINAGE AND 

UTILITIES > COMPONENTS > Common > Storm Data > Global Storm Events. 

 

 Using the mouse, click and drag from left to right to select the table contents. Left click and select Copy 

with Headers from the prompt that opens, as shown below.  

 

 Minimize OpenRoads and open Excel. 

a. Paste the clipboard contents into a new or blank workbook. 

 

b. Format the table to FDOT font and insert a row at the top for the table title as shown below.  
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c. Save As ‘Global_Storm_Events.xlsx’ in the example workset folder, drainage: eng_data 

subfolder.  

 

d. Close Excel. 
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Exercise 6.5 Export FDOT Flex Tables to Excel 

 In OpenRoads, navigate through the following path and open Flex Tables: DRAINAGE AND 

UTILITIES > ANALYSIS > Analysis Views > Flex Tables: 

 

 From the Hydraulic Analysis tab, select the FDOT-Conduit-StormTab table and double-click to open.  

   

a. Select the  Export to File… icon from the upper left of the FlexTable window.  

 

b. Save as type: Comma Delimited File (*.csv), with the File Name: FDOT-Conduit-

StormTab.csv. 

 

c. Close the Flex Table. 

 Navigate through the following path to quickly open the workset drainage folder: OPENROADS 

MODELING>FDOT> Resources > Explore Directories > Current Workset.  

 



Chapter 6 DRAINAGE DOCUMENTATION ______________________________________________________________ Exercises 

FDOTCONNECT for ORD Workflows ©2020 FDOT  6-144 

 Open the FDOT-Conduit-StormTab.csv file in Excel and update formatting with the following: 

 

a. Select from cells A1 to AD5 

i. Add borders (Home: Font: Borders: All Borders) 

ii. Change font to FDOT 

b. Adjust units for significant digits and reshape column widths as needed 

c. Add title row and input “STORM DRAIN TABULATION FORM” 

 

 Save as .xlsx and close Excel. 

 Repeat Steps 1 through 5 for FDOT-Outfall and FDOT-Catchment Flex Tables. 

 

 

 In OpenRoads, from the FDOT-Catchment Flex Table, open tables for each Subarea Collection by 

clicking the ellipse. 
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a. Follow methodology from Exercise 6.4 to copy/paste table data and format in Excel.  

 

b. Save As Subareas_DR-101.xlsx and SubAreas_DR-103.xlsx respectively: 

 

 

 Save and close all Excel files. 
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Exercise 6.6 Compute Center: Run 4 in/hr Absolute Intensity (Spread Only) Scenario 

 In OpenRoads, navigate through the following path and open the Compute Center: DRAINAGE AND 

UTILITIES > ANALYSIS > Analysis Tools > Compute Center. 

 From the Scenario pull-down, select 4 in/hr Absolute Intensity (Spread Only) and compute.  

 

 Once computation is complete, close the Compute Center and Calculation Summary. 

Exercise 6.7 Export FDOT-Spread Flex Table to Excel 

 In OpenRoads, navigate through the following path and open Flex Tables: DRAINAGE AND 

UTILITIES > ANALYSIS > Analysis Views > Flex Tables. 

 From the Hydraulic Analysis tab, select the FDOT-Conduit-StormTab table and double-click to open.  

   

a. Select the  Export to File… icon from the upper left of the FlexTable window.  

 

b. Save as type: Comma Delimited File (*.csv), with the File Name: FDOT-Spread.csv. 
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c. Close the Flex Table. 

 Navigate through the following path to quickly open the workset drainage folder: OPENROADS 

MODELING>FDOT> Resources > Explore Directories > Current Workset.  

 

 Open the FDOT-Spread.csv file in Excel and update formatting with the following: 

 

a. Select from cells A1 to V3 

i. Add borders (Home: Font: Borders: All Borders) 

ii. Change font to FDOT 

b. Adjust units for significant digits and reshape column widths as needed 

c. Add title row and input “SPREAD CALCULATIONS” 

 

 Save as .xlsx and close Excel. 

 Save DRPRRD01.dgn and close OpenRoads. 
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Exercise 6.8 Create FDOT storm drain documentation sheet and place labels 

 Reopen OpenRoads Designer and locate “_Blankfile.dgn” at the root of the workset folder 

structure. Select this file and then select “OPEN” to open it. 

 Navigate through the path to Create File, OPENROADS MODELING> FDOT > Actions > Create File 

and complete selections as follows: 

 

• Discipline = “DRAINAGE” 

• File Group = “Drainage Sheet Files” 

• File Type = “DRMPRD”  

• File Sequence # = “01” 

• County = “Wakulla” (Coordinate System = FL83-NF) 
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 Select Create – Open File and Close after the new file is open. 

 Navigate through the following path to open the References dialog and attach the files listed below: 

DRAINAGE AND UTILITIES>HOME>PRIMARY>Attach Tools> References>Tools>Attach 

a. Survey folder: GDTMDR01.dgn 

b. Drainage folder: PDPLRD01.dgn, DRPRRD01.dgn 

c. Roadway folder: ALGNRD01.dgn, MODLRD_MainLine01.dgn, DSGNRD01.dgn, 

Aerials.dgn 

 

 Set Annotation Scale to 1” = 50’ from the path: DRAINAGE AND UTILITIES>DRAWING>Drawing 

Scales>. 

 

 Turn off levels from Reference files as needed and save settings. 

a. Examples of undesired levels include the model handles and labels in the PDPLRD01.dgn. 

   

 The new sheet created in this exercise will use existing named boundaries created in Chapter 4 exercises 

in the DRPRRD01.dgn file. From the following path, open Named Boundaries Manger: DRAINAGE 

AND UTILITIES>DRAWING PRODUCTION>Named Boundaries. 
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 Expand the Named Boundaries to Plan Groups: CL_SR61: Drainage Plan 1. Right click on Drainage 

Plan 1 and select Create plan drawing. 

 

a. This action creates two new models in this DGN, Drainage Plan 1 Views and [Sheet] Views. 
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 Switch back to the Default model and set active level to TextDetails. 

 

 Open the Place Label tool from the path: DRAINAGE AND UTILITIES> DRAWING 

PRODUCTION>Notes> Place Label. 

 

a. Update settings for Text Favorite: _SU_PLAN_NODE_ID and select one of the drainage areas  

as shown below: 
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b. Left click in the center of the area to accept placement. Repeat for second drainage area: 
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Exercise 6.9 Place Tables, from Excel, in FDOT Storm Drain Documentation Sheet 

This exercise will place the drainage documentation tables generated in Exercises 6.1 through 6.7 into the sheet 

created in Exercise 6.8.  

 In DRMPRD01.dgn, switch to the Drainage Plan 1 [Sheet] Views Model and navigate through the path 

to open Place Table, DRAINAGE AND UTILITIES> DRAWING PRODUCTION>Tables> Place 

Table. 

a. Select the icon for From file. 

 

b. Select the ellipse next to File Name and locate the drainage/eng_data folder, where tables were 

saved in earlier exercises. 

 

c. Choose the file FDOT-Spread.xlsx and select OK to the prompt shown below: 

 

d. The completed settings for the Place Table tool are shown below: 
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e. Once the table has finished generating, use the cursor to choose the table location. Left click to 

accept and place.  

 

 Repeat Step 1 for the remaining drainage documentation tables.  

a. Note, some larger Excel tables may generate the following alert. For this example, select Yes. 
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 Move tables and organize as needed to best fit the sheet. The following tables are presented on this 

example:   

a. STORM DRAIN TABULATION FORM 

b. OUTFALL CONDITIONS 

c. SPREAD CALCULATIONS 

d. DRAINAGE AREA TABULATIONS 

e. SUBAREA CATCHMENTS 

f. HYDRAULIC MODEL INVENTORY 

g. GLOBAL STORM ANALYSIS 
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7 ADVANCED TOPICS  

UNDER DEVELOPMENT: 

Basic workflows for FDOT Storm Drain design are detailed in Chapters 1-6. Advanced topics, such as those 

listed below are under development to provide additional guidance and considerations for OpenRoads Designer 

modeling capabilities. 

• Culverts and Cross Drain Analysis 

• Ditches 

• Pond Design (time varying / dynamic conditions) 

• Utility Conflicts Matrix 

• Show Gutter Flow Tool 

• Importing existing Geopak Drainage or ASAD networks. 

Submit requests or topic suggestions to cadd.support@dot.state.fl.us 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

mailto:cadd.support@dot.state.fl.us


Chapter 8 FREQUENTLY ASKED QUESTIONS ____________________________________________________________ DGNLib 

FDOTCONNECT for ORD Workflows ©2020 FDOT  8-157 

8 FREQUENTLY ASKED 
QUESTIONS 

DGNLIB 

HYDRAULIC SEED DATA 

Q: What was the basis of hydraulic property input used to populate the FDOT resources? 

A: Hydraulic input is comparable to GEOPAK drainage and verified vs. 
standard plans. Where applicable catalog notes are available to clarify input. 

 

Q: How were the new resources validated? Does the new software run calculations accurately? 

A: Validation models were prepared to compare results from OpenRoads 
with FDOT Drainage Design Guide examples. 

FEATURE DEFINITIONS 

Q: What should I do if I want to change the structure type or Feature Definition?  

A: If the Feature Definition is changed from the pulldown menu in the element 
Properties, the Symbology Properties will automatically update. However, 
the Hydraulic Properties are automatically assigned only once, at first 
placement and will not automatically update to the new Feature Definition. 
However, the Hydraulic Properties can be edited to match the correct 
structure in the Utility Properties dialog. 

 

Q: All the structures have centered tops and bottoms. What do I need to do to get an eccentric 
configuration?  

A:. Recommendation is to keep models with delivered features. We 
anticipate future enhancements from Bentley will allow for these 
configurations to be more easily modified. 

Q: If I make a custom Feature Definition for a J-Bottom structure in a design file, can I reuse it for other 
design files or other projects to avoid?  

A:. Create a new DGNLib and copy in the custom Feature Definition(s). Save 
the new DGNLib in the C:\FDOTConnect\Workspaces\FDOT\Standards\ 
Dgnlib\Feature Definitions folder. 
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DGN 

Q: Can more than one person work in a design file at a time?  

A: No, however design files with drainage models can be referenced into 
other DGNs. 

MODEL 

Q: Do I need StormCAD activated? 

A: No, as long as networks contain less than 100 nodes. Also, separate 
network(s) can be included in separate dgns. 

Q: How are drainage designers notified of model changes that affect drainage placement rules? 

A: No apparent software official notification. We recommend having 
designers provide a quality control on the drainage items.  

LAYOUT 

 

NODES 

Q: What is the Define Catchment checkbox for, and what should I know before using it?  

A: We recommend using other tools available, or other COTS products to 
assist in delineating boundaries. Note, the Bentley Define Catchment tool 
appears to increase the amount of information the software needs to process 
and may increase processing times. Also, since the areas automatically 
update, any manual edits will not ‘hold’. If the terrains are simple and the 
automatic drainage area does not require further tweaks, this could be an 
efficient way to set catchments. 

CONDUIT 

Q: Why are there different Feature Definition Categories for pipes, Drainage Pipes and Culverts? What’s 
the difference?  

A: The only difference between these two types of conduit is that the ‘Is 
Culvert’ property is set to ‘True’. This is necessary to run culver or cross drain 
calculations, especially when overtopping analysis is required.  

Q: Is there an option to set barrel spacing?  

A: Currently no. This function is pending further enhancement from Bentley 
in upcoming releases.  
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CATCHMENTS 

Q: Why do the drainage areas not work with curves? 

A: This is an observed Bentley defect. If a closed shape includes curved 
elements, the Place Catchment tool converts the shape into chords.  

Q: Why is the automated weighted C value function gone? 

A: This has been reported to Bentley, and pending enhancement in a future 
release.  

Q: Is there a recommended work-around to avoid manually calculating percent land cover or weighted C 
values? 

A: Since OpenRoads does handle multiple catchments to a single node, a 
possible workaround using land cover shapes for grass or pavement, etc. is 
to break up drainage divides by land cover.  

COMPUTE 

SCENARIOS 

INPUT  

Q: How do I compute with Minor Losses? 

A: The default set up provided in FDOT DGNLib is the Standard loss method 
where a user-defined loss coefficient is used to calculate the head loss based 
on the velocity head of the exit conduit. This input is provided at each 
structure and can be managed either in element properties or Headloss 
Alternatives. For further reference, see ‘Junction Headloss Methods’ in 
Bentley Help. 

AUTOMATED DESIGN 

Q: Can I use automated design for drainage networks? 

A: Yes, but recommend reviewing the Drainage and Utilities ‘Design 
Priorities’ . These may result in a different design than that of following FDOT 
Drainage Design Guide.  For example, “Pipe Capacity Should Be Greater 
Than the Discharge” could result in larger or deeper pipes than necessary to 
meet 1’ HGL clearance. FDOT recommendation is to design systems using 
Analysis scenarios. 

Q: Surcharging: tracing HGL from downstream to upstream, why does the HGL increase along the pipe – 
to above the upstream structure elevation, but resets to the upstream structure top for the next upstream 
pipe? 



Chapter 8 FREQUENTLY ASKED QUESTIONS ____________________________________________________ Plans Preparation 

FDOTCONNECT for ORD Workflows ©2020 FDOT  8-160 

A: StormCAD solver is not meant for undersized systems, but rather is 
intended to design systems not to flood. See communities wiki link below: 
https://communities.bentley.com/products/hydraulics___hydrology/w/hydra
ulics_and_hydrology__wiki/11166/why-is-the-hgl-reset-to-rim-elevation-for-
flooded-structures 

Q: Can automated design avoid utility conflicts automatically? 

A: Not directly, however you can use view utility conflicts with the Conflict 
Resolution tool. 

PLANS PREPARATION 

ANNOTATION 

Q: How automated are the labeling and annotation tools? 

A: The integrity of dynamic labels using Place Note and Place Label are 
maintained since they’re based on the properties of the labeled element. If 
properties change, the labels change.  

PROFILE RUNS 

Q: Can I present lateral pipes in profiles and cross sections?   

A:.Yes, using the 3D Cut tool, all 3D elements through the model will be 
shown. The 3D cut elements shown can be turned off by level as needed. 

DOCUMENTATION 

Q: Is there a VBA script to run or format the StormTabs?  

A: No, the StormTab Flex Table may be exported for use in design 
documentation. Formatting may be performed within the Bentley Report Tool 
or in external programs such as Excel.  

Under Development 

 

Caution synchronize drawing. 

Explanation of FDOT design priorities vs. Drainage & Utilities 
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